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1
Installing the Operating System

Ä
CAUTION: Do not add optional hardware or third-party devices to your computer until the operating 
system is successfully installed. Doing so may cause errors and may prevent the operating system from 
installing properly.

Ä
CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL 
THE PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the 
software that runs the computer or prevent its proper installation.

The first time the computer is turned on, the operating system is automatically installed. This 
takes approximately 10 minutes, depending on the system hardware configuration. At the 
beginning of the installation process, you are prompted to select the appropriate language for the 
operating system. Read and follow the instructions that appear on the screen to complete the 
installation. During this process, do not turn off your computer unless you are directed to do so.

✎ If the computer shipped with more than one operating system language on the hard drive, the 
installation process could take up to 60 minutes.

1.1 Installing or Upgrading Device Drivers 
To install hardware devices such as a printer, a display adapter, or network adapter after the 
operating system installation is completed, the operating system needs access to the appropriate 
software drivers for the devices.

If prompted for the I386 directory, replace the path specification with C:\i386, or click Browse in 
the dialog box to locate the i386 folder. This action points the operating system to the appropriate 
drivers.

Obtain the latest support software, including support software for the operating system from 
www.hp.com. Click support & drivers, select Download drivers and software, enter the model 
number of the computer, and press Enter.

You can also obtain the latest support software on CD. The following Web site provides 
information about purchasing a support software CD subscription:

http://h18000.www1.hp.com/support/files/desktops/us/purchase.html 

✎ If the computer has an optical CDRW drive, install the appropriate application to allow you to 
write to the drive. To install the application, double-click the Setup Software icon on the desktop 
or the application launcher and select the Easy CD Creator and Direct CD options when 
prompted.
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Installing the Operating System
1.2 Transferring Files and Settings
Use the Microsoft Windows XP Files and Settings Transfer Wizard to move files and settings 
from an old computer to a new one. Click Start > All Programs > Accessories > System Tools 
> Files and Settings Transfer Wizard.

1.3 Backing Up and Restoring Files

1.3.1 Creating a Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to create a backup file or tape.

✎ You can save a backup file to a hard disk, a floppy disk, CD, USB flash media device, tape drive, 
or to any other removable or nonremovable media.

1.3.2 Restoring from the Backup File—Windows XP Professional
1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Use the Backup or Restore Wizard to restore files from a backup file.

✎ A backup file can be saved on a hard disk, a floppy disk, CD, USB flash media device, tape drive, 
or any other removable or nonremovable media.

1.4 Converting to NTFS
Windows XP Professional

To convert a FAT or FAT32 volume to NTFS,

1. Click Start > All Programs > Accessories > Command Prompt.

2. Type convert drive_letter: /fs:ntfs (where drive_letter is the volume to be converted) and 
press Enter.
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Installing the Operating System
1.5 HP Software
The Microsoft Windows XP Professional operating system is preinstalled on the computer and 
will be configured automatically the first time the computer is turned on. The following HP 
software may also be installed at that time on selected models: 

■ Computer Setup Utilities

■ HP Support Software including device drivers

■ Configuration Record

■ Online Safety & Comfort Guide

■ Power Management with energy saver features

■ Security Management tools

■ Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest 
version of these files, in English and selected other languages, in one of three ways:

■ Support Software CD 

■ HP Web site at www.hp.com 

■ Restore Plus! CD, which is supplied with many HP models

✎ Additional HP software may be required in certain situations. 
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2
Setup Utilities and Diagnostics Features

Setup Utilities (F10) and diagnostic features provide information needed about the computer 
system when contacting Customer Support. You can also use these tools to:

■ Change factory default settings and to set or change the system configuration, which may be 
necessary when you add or remove hardware.

■ Determine if all of the devices installed on the computer are recognized by the system and 
are functioning properly.

■ Determine information about the operating environment of the computer.

■ Solve system configuration errors detected but not automatically fixed during the Power-On 
Self-Test (POST).

■ Establish and manage passwords and other security features.

■ Establish and manage energy-saving timeouts.

✎ All features identified in this chapter may not be available on all HP products.

2.1 Power-On Self-Test (POST)
POST is a series of diagnostic tests that runs automatically when the system is turned on. POST 
checks the following items to ensure that the computer system is functioning properly:

■ Keyboard

■ Memory modules

■ Diskette drives

■ All mass storage devices

■ Processors

■ Controllers

✎ If the Power-On Password is set, a text box password prompt appears on the screen while POST 
is running. You must enter the password before continuing. Refer to Chapter 3, Section 3.1, 
“Initial Configuration and Deployment.” for information on setting, deleting, or bypassing the 
password.

If POST finds an error in the system, an audible and/or visual message occurs. For POST error 
messages and their solutions, refer to Appendix C, “POST Error Messages.”
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2.2 Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

■ Change factory default settings.

■ Set the system date and time.

■ Set, view, change, or verify the system configuration, including settings for processor, 
graphics, memory, audio, storage, communications, and input devices.

■ Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, 
or USB flash media devices.

■ Enable or disable Quick Power-On Self Test, which is faster than a full boot but does not run 
all of the diagnostic tests run during a full boot.

■ Enter the Asset Tag or property identification number assigned by the company to this 
computer.

■ Establish a supervisor password that controls access to Computer Setup (F10) Utility and the 
settings described in this section.

■ Secure integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

■ Enable or disable Master Boot Record (MBR) Security. 

■ Enable or disable removable media boot ability.

■ Enable or disable legacy diskette write ability (when supported by hardware).

2.2.1 Using Computer Setup (F10) Utilities
You can only access Computer Setup by turning the computer on or restarting the system. 
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer. If you are in Microsoft Windows, click Start > 
Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter 
Computer Setup.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility.

3. The Computer Setup Utility screen is divided into seven menu headings:

❏ System Information

❏ Standard CMOS Features

❏ Advanced BIOS Features

❏ Advanced Chipset Features

❏ Integrated Peripherals

❏ Power Management Setup

❏ PnP/PCI Configurations
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Six action choices are listed on the Computer Setup Utility screen:

❏ PC Health Status

❏ Load Optimized Defaults

❏ Set Supervisor Password

❏ Set User Password

❏ Save & Exit Setup

❏ Exit Without Saving

Use the arrow keys to select the appropriate heading, and then press Enter. Use the arrow 
(up and down) keys to select the option you want, and then press Enter. To return to the 
previous screen, press Esc.

4. To apply and save changes, press F10 or select Save & Exit Setup on the Computer Setup 
Utility screen and press Enter.

If you have made changes that you do not want applied, select Exit Without Saving and 
press Enter.

Ä
CAUTION: Do NOT turn computer power OFF while the ROM is saving F10 Computer Setup changes 
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 
Setup screen.
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2.2.2 Computer Setup Menu

Computer Setup 
Heading Option Description

System 
Information

Displays Product Name
Processor Type
Cache Size
Memory Size
System ROM
Integrated MAC
UUID
System Serial #
Asset Tracking Number
Enter Asset Tag No.

Standard 
CMOS 
Features

Date (mm:dd:yy) Allows you to set system date.

Time (hh:mm:ss) Allows you to set system time.

IDE Channel 0 Master
IDE Channel 0 Slave
SATA IDE Channel 1 
Master
SATA IDE Channel 2 
Master

For each, allows you to:
• HDD Self-Test (SATA only)

•SMART Status Check
•HDD Short Self-Test
•HDD Extended Self-Test

• IDE Auto-Detection 
• Extended IDE Drive

• None
• Auto

• Access Mode
• CHS (PATA only)
• LBA (PATA only)
• Large
• Auto

Drive A Identifies the highest capacity media type accepted by 
the diskette drive.

Halt On Allows you to set at:
• All Errors
• No Errors
• All, but Keyboard
• All, but Diskette
• All, but Diskette/Keyboard

POST Delay Allows you to set a POST delay.

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced 
BIOS Features

Removable Device Boot 
Seq.

Allows you to specify the order in which attached devices 
(such as an FDD, an LS120, or a Zip Drive) are checked 
for a bootable operating system image.

Hard Disk Boot Seq. Allows you to specify the order of attached hard drive 
devices (such as USB HDD storage, USB2 DriveKey, or 
USB flash media). The first drive in the order has priority 
in the boot sequence and is recognized as drive C (if any 
devices are attached).

CD-ROM Boot Seq. Allows you to specify the order in which attached 
CD-ROM drives (including USB ODD) are checked for a 
bootable operating system image.

Network Boot Seq. Allows you to specify the order in which network devices 
(including UP NIC cards) are checked for a bootable 
operating system image.

MBR Security Enables/disables the VIRUS warning feature for IDE Hard 
Disk boot sector protection.
When this function is enabled and someone attempts to 
write data into this area, the BIOS responds with a 
warning message on screen and an alarm beep.

Quick Power On Self Test Enables/disables the system to skip certain tests while 
booting.
Enabling this feature decreases the time required to boot 
the system.

First Boot Device
Second Boot Device
Third Boot Device
Fourth Boot Device

Allows you to specify which devices will boot first, 
second, third, and fourth.

✎ MS-DOS drive lettering assignments may not apply 
after a non-MS-DOS operating system has started.

Boot Up NumLock Status Allows you to set the default NumLock status on or off.

Security Option Allows you to set to either Always or Setup.

APIC Mode Enables/disables the APIC support.

MPS Version Control for 
OS

Allows you to set the MPS version for the OS.

HDD S.M.A.R.T. Capability Enables/disables SMART capability on the hard drive.

ASF Support Enables/disables ASF

BIOS Write Protection Enables/disables BIOS write protection.

Advanced 
Chipset 
Features

UMA Frame Buffer Size Allows you to set the size of the UMA frame buffer.

Computer Setup (Continued)

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Advanced 
Chipset 
Features 
(continued)

Video Display Devices Allows you to set to:
• Auto
• CRT only
• DFP only
• CRT Force, DFP Auto

Init Display First Allows you to select the primary VGA source.

Surroundview Allows you to enable/disable Surroundview only if PCI-E 
GFX add-on card is ATI. Provides support for up to three 
independent monitors (available with the unified drivers).

Auto Detect PCI Clk Enables/disables PCI Clk auto detection.

Spread Spectrum Enables/disables spread spectrum.

Integrated 
Peripherals

South OnChip PCI Device Allows you to enable/disable:
• On Chip IDE Controller
• Onboard AC97 Audio
• Onboard Chip SATA

• SATA Disabled
• IDE Controller (non-RAID)
• RAID Controller

• Onboard LAN
• Onboard LAN Boot ROM

OnChip USB Controller Enables/disables the USB controller.

USB Legacy Support Enables or disables the USB Legacy feature.

Front Panel USB Port Enables/disables the front panel USB port and the two 
USB ports located on the back of the computer under the 
NIC connector.

Onboard FDC Controller Enables/disables onboard FDC controller.

Onboard Serial Port Allows you to disable or select setting for the onboard 
serial port.

Onboard Parallel Port Allows you to disable or select setting for onboard 
parallel port.

Parallel Port Mode Allows you to select parallel port mode.

ECP Mode Use DMA If Parallel Port Mode is set to ECP or ECP+EPP, allows you 
to set the ECP Mode Use DMA to 1 or 3.

Power 
Management 
Setup

ACPI Function Enables/disables ACPI functions.

ACPI Suspend Type Allows you to set type of ACPI suspend.

MODEM Use IRQ Select IRQ for the device.

Computer Setup (Continued)

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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Power 
Management 
Setup 
(continued)

After AC Power Loss Allows you to select:
• Last State
• On
• Off

PowerOn by PCI Card Enables/disables capability of powering on by PCI card.

AMD Cool’n’Quiet Allows you to set the AMD Cool’n’Quiet to auto or to 
disable it.

RTC Alarm Resume Enables/disables resumption of RTC alarm.

Date (of Month) If RTC Alarm Resume is enabled, allows you to select the 
day of the month for resumption of RTC alarm.

Resume Time (hh:mm:ss) If RTC Alarm Resume is enabled, allows you to select 
what time the RTC alarm will resume.

PnP/PCI 
Configurations

Reset Configuration Data Enables/disables automatic reconfiguration.
Default is Disabled. Select Enabled to reset Extended 
System Configuration Data (ESCD) when you exit Setup, 
if you have installed a new add-on and the system 
reconfiguration has caused such a serious conflict that the 
OS cannot boot.

Resources Controlled By Allows you to select whether resources are controlled 
automatically or manually.
BIOS can automatically configure all the boot and 
Plug-and-Play-compatible devices. If you choose Auto, 
you cannot select IRQ DMA and memory base address 
fields, since BIOS automatically assigns them.

IRQ Resources
• IRQ-3 assigned to
• IRQ-4 assigned to
• IRQ-5 assigned to
• IRQ-7 assigned to
• IRQ-10 assigned to
• IRQ-11assigned to
• IRQ-12assigned to
• IRQ-14assigned to
• IRQ-15assigned to

When resources are controlled manually, allows you to 
assign each system interrupt a type, depending on the 
type of device using the interrupt.
Legacy ISA for devices compliant with the original PC AT 
bus specification, PCI/ISA PnP for devices compliant with 
the Plug and Play standard whether designed for PCI or 
ISA bus architecture.

Assign IRQ for VGA Enables/disables capability of assigning IRQ for VGA.

Assign IRQ for USB Enables/disables capability of assigning IRQ for USB.

Computer Setup (Continued)

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.3 Recovering the Configuration Settings
Recovering the configuration settings established in the Computer Setup (F10) Utility requires 
that you first back up the settings before a recovery is needed.

The CMOS Save/Load utility ROMPAQ can be found at http://www.hp.com under the support 
and drivers for the HP Business Desktop dx5150. Download the ROMPAQ files into a folder on 
a removable storage device. It is recommended that you save any modified computer 
configuration settings to a diskette, a USB flash media device, or a diskette-like device (a storage 
device set to emulate a diskette drive), and save the diskette or device for possible future use.

2.3.1 Backing up the CMOS
1. Make sure the computer you want to back up is turned on. Connect the removable storage to 

the computer.

2. In Windows, click Start > Run, type CMD, and click OK to open a DOS 
command window.

3. Type N:\folder\BIOS.exe SAVE:ABC001.DAT (where N is the drive letter of the 
removable storage) to save the CMOS setting to the removable storage device.

PC Health 
Status

System Information Lists:
• CPU Temperature
• System Temperature
• CPU Fan Speed
• System Fan Speed
• System Fan Fail Check (enable/disable)
• Fan Control (auto/disable)

Load 
Optimized 
Defaults

Allows you to reset Computer Setup to factory defaults.

Set Supervisor 
Password

Allows you to establish a password to control access to 
Computer Setup. Allows you to boot computer and 
change Computer Setup.

Set User 
Password

Allows you to establish a password to control access to 
the computer. Allows you to boot the computer and view 
Computer Setup.

Save & Exit 
Setup

Allows you to save current settings and exit Computer 
Setup.

Exit Without 
Saving

Allows you to exit Computer Setup without saving 
changes.

Computer Setup (Continued)

Heading Option Description

✎ Support for specific Computer Setup options may vary depending on the hardware configuration.
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2.3.2 Restoring the CMOS
1. Make sure the target computer is turned on. Connect the removable storage to the 

target computer.

2. In Windows, click Start > Run, type CMD, and click OK. to open a DOS 
command window.

3. Type N:\folder\BIOS.exe LOAD:ABC001.DAT (where N is the drive letter of the 
removable storage) to load the custom CMOS setting onto the target system.

2.4 Diagnostics for Windows
The Diagnostics for Windows (DFW) utility allows you to view information about the hardware 
and software configuration of the computer while running Microsoft Windows XP. It also allows 
you to perform hardware and software tests on the subsystems of the computer.

When you invoke Diagnostics for Windows, the current configuration of the computer is shown 
on the Overview screen. There is access from this screen to several categories of information 
about the computer and the Test tab. You can save to a file or print the information in every 
screen of the utility.

✎ To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem is 
indicated by an error message under the subsystem name in the Test window or by shaded check 
boxes that you cannot select.

Use Diagnostics for Windows in the following instances to:

■ Determine if all the devices installed on the computer are recognized by the system and 
functioning properly. Running tests is optional but recommended after installing or 
connecting a new device.

■ Third party devices not supported by HP may not be detected. Save, print, or display the 
information generated by the utility.

2.4.1 Detecting Diagnostics for Windows
Some computers ship with the Diagnostics for Windows preloaded, but not preinstalled.

To determine whether Diagnostics for Windows is installed:

1. Access the location of the Diagnostics icons in Windows XP Home or Windows XP 
Professional by selecting Start > Control Panel > Performance and Maintenance.

2. If icons for Configuration Record and Diagnostics for Windows are present, the Diagnostics 
for Windows utility is installed. If the icons are not present, the utility is either not preloaded 
or not installed. 

2.4.2 Installing Diagnostics for Windows 
If Diagnostics for Windows is not preloaded, you can download the Diagnostics for Windows 
SoftPaq from the following Web site:

http://www.hp.com/support/files
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Once you download the software onto the hard drive, install the software as follows: 

1. Close all Windows applications.

2. Install the Diagnostics for Windows utility:

❏ In Windows XP, select Start > Setup Software icon. Select Diagnostics for Windows, 
click Next, then follow the instructions on the screen.

❏ If the Setup Software icon is not on the Desktop or on the Start menu, run the Setup 
program from the C:\CPQAPPS\DIAGS directory or select Start > Run and type the 
following in the command line: C:\CPQAPPS\DIAGS\SETUP.

3. Click Next to install Diagnostics for Windows.

4. After the program has finished installing, you may be prompted to restart the computer, or 
the computer may automatically restart. If prompted, click Finish to restart the computer or 
Cancel to exit the program. You must restart the computer to complete the installation of 
Diagnostics for Windows.

✎ If you want to upgrade an existing version of Diagnostics for Windows installed on the 
computer, visit http://www.hp.com/support/files and click on an applicable product. Locate the 
desired software and download the latest version. Execute the downloaded file and select Repair 
to update the installed version. This will cause the new version to overwrite the old version.

2.4.3 Using Categories in Diagnostics for Windows 
To use categories:

1. Click Start > HP Information Center > Diagnostics for Windows. You can also select the 
Diagnostics for Windows icon, located in the Control Panel.

The screen displays the overview of the computer hardware and software.

❏ In Windows 2000 Professional, select Start > Settings > Control Panel, then select 
Diagnostics for Windows.

❏ In Windows XP Home and Windows XP Professional, select Start > Control Panel > 
Performance and Maintenance, then select Diagnostics for Windows.

2. For specific hardware and software information, select a category from the Categories 
pull-down menu or the appropriate icon on the toolbar.

✎ As the cursor moves over the toolbar icons, Windows displays the corresponding category name.

3. To display more detailed information in a selected category, click More in the Information 
Level box in the lower left corner of the window or click Level at the top of the screen, and 
then select More.

4. Review, print, and/or save this information as desired.

❏ To print the information, click File > Print. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current 
Category. Click OK to print the report you selected.

❏ To save the information, click File > Save As. Select one of the following options: 
Detailed Report (All Categories), Summary Report (All Categories), or Current 
Category. Click OK to save the report you selected.

5. To exit Diagnostics for Windows, on the File menu, click Exit.
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Menu Bar—File, Categories, Navigation, Level, Tab, Help 
At the top of the Diagnostics for Windows screen is a menu bar consisting of six pull-down 
menus. Select a menu for the following system information:

■ File—Save As, Print, Printer Setup, Exit.

■ Categories.

❏ System—System board, ROM, date, and time.

❏ Asset Control—Asset tag, system serial number, and processor.

❏ Input Devices—Keyboard, mouse, and joystick(s).

❏ Communication—Ports.

❏ Storage—Storage drives.

❏ Graphics—Graphics.

❏ Memory—System board and Windows memory.

❏ Multimedia—Optical storage (CD, DVD, and so on) and audio.

❏ Windows—Windows.

❏ Architecture—PCI Device.

❏ Resources—IRQ, I/O, and Memory Map.

❏ Health—Status of system temperature and hard drives.

❏ Miscellaneous—CMOS, DMI, BIOS, System, Product Name, and Serial Number.

■ Navigation—Previous Category (F5), Next Category (F6).

■ Level—Less (F7), More (F8) <information on the screen>.

■ Tab.

❏ Overview—Displays general information about the computer. This window is displayed 
when first starting the utility. The left side of the window shows hardware information, 
while the right side shows software information.

❏ Test—Allows you to choose various parts of the system to test. You can also choose the 
type of test and testing mode.

❏ Status—Displays the status of each test in progress. You can cancel testing by clicking 
the Cancel Testing button.

❏ Log—Displays a log of tests for each device.

❏ Error—Displays any errors that occurred during device testing. The window lists the 
device being tested, the type and number of errors, and the error code.

■ Help—Contents, How to use Help, About.
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2.4.4 Running Diagnostic Tests in Diagnostics for Windows
To run diagnostic tests:

1. Click Start > HP Information Center > Diagnostics for Windows. 

Alternately, you can access Diagnostics for Windows using the Control Panel.

The screen displays the overview of the computer hardware and software. Five tabs are 
displayed below the row of icons: Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and select Test.

3. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device. Requires no user intervention if 
Unattended Mode is selected.

❏ Complete Test—Runs maximum testing of each device. The user can select Interactive 
Mode or Unattended Mode.

❏ Custom Test—Runs only the tests you select. To select specific devices or tests, find the 
device in the list, then select the check box beside each test. When selected, a red check 
mark is displayed in the box. Some tests selected may require user intervention.

✎ To test all subsystems, you must log in as the administrator. If you do not log in as the 
administrator, you will be unable to test some subsystems. The inability to test a subsystem is 
indicated by an error message under the subsystem name in the Test window or by shaded boxes 
that you cannot check.

4. Select Interactive Mode or Unattended Mode. In Interactive Mode, the diagnostic software 
prompts you for any required input during tests. Some tests require interaction and display 
errors or halt testing if selected in conjunction with Unattended Mode.

❏ Interactive Mode provides maximum control over the testing process. You determine 
whether the test passed or failed. The software may prompt you to insert or remove 
devices.

❏ Unattended Mode does not display prompts. The software displays all discovered errors 
when testing is complete.

5. Click the Begin Testing button at the bottom of the window. Test Status is displayed, 
showing the progress and result of each test. For more details on the tests run, click the Log 
tab or click Tab at the top of the screen and select Log.

6. To view a test report, select one of three tabs: 

❏ Status—Summarizes the tests run, passed, and failed during the current testing session.

❏ Log—Lists tests run on the system, the numbers of times each test has run, the number 
of errors found on each test, and the total run time of each test.

❏ Error—Lists all errors found on the computer with their error codes.

7. To save a test report:

❏ Select the Log tab, then click Save to save a Log tab report.

❏ Select the Error tab, then click Save to save an Error tab report.
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8. To print a test report:

❏ If the report is on the Log tab, on the File menu, click Save As, and then print the file 
from the selected folder.

❏ If the report is on the Error tab, select the Error tab, and then click Print.

9. If errors are found, click the Error tab to display more detailed information and 
recommended actions. 

10. Click Print or save the error information for future reference.

11. To exit Diagnostics for Windows, on the File menu, click Exit.

2.5 Configuration Record
The Configuration Record utility is a windows-based information-gathering tool that gathers 
critical hardware and software information from various computer subsystems. The information 
includes such things as the ROM, asset tag, processor, physical drives, PCI devices, memory, 
graphics, operating system version number, operating system parameters, and the operating 
system startup files to give a complete view of the computer. Configuration Record provides a 
means for automatically identifying and comparing configuration changes, and has the ability to 
maintain a configuration history. You can save the information as a history of multiple sessions.

This utility allows the resolution of problems without taking the computer offline and assists in 
maximizing the computer availability. The information obtained by the utility is useful in 
troubleshooting system problems and streamlines the service process by enabling quick and easy 
identification of system configurations.

The utility displays it findings in a Now.log file. If the original Base.log file is present in the 
cpqdiags directory, the Base.log file is displayed next to the Now.log file in a split window with 
the differences between the two highlighted in the color red.

2.5.1 Installing Configuration Record 
The Configuration Record is part of Diagnostics for Windows and is automatically installed at 
the same time as Diagnostics for Windows.

2.5.2 Running Configuration Record
To run this program:

1. Click Start > HP Information Center > Configuration Record.

Alternately, you can access Diagnostics for Windows using the Control Panel.

✎ The Configuration Record utility has two view options: Show Changed Items Only and Show 
All. The default view is Show Changed Items Only, therefore all the text is displayed in the 
color red since it shows only the differences. Switching to Show All displays the complete, 
comprehensive view of the system.

2. The default view is Show Changed Items Only. To view all the information gathered by 
Configuration Record, click View at the top of the window and select Show All, or click the 
Show All Items icon.

3. To save the information in the left or right window, select File > Save Window File and 
then select Left Window File or Right Window File.
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✎ Saving the configuration of the computer periodically allows you to keep a history of the 
configuration. This history may be useful to you in the future if the system encounters a problem 
that requires debugging.

4. To exit Configuration Record, on the File menu, click Exit.

2.6 Remote Diagnostics Enabling Agent
This utility provides a Web browser interface to Diagnostics for Windows. It enables remote 
control of the diagnostics and facilitates easy transfer of computer information from remote 
machines to a service provider.

The Remote Diagnostics Enabling Agent captures hardware configuration and provides the 
ability to perform tests remotely to diagnose computer problems. In addition, the Remote 
Diagnostics Enabling Agent identifies any computer hardware device problems signaled by the 
HP Management Agents. The Remote Diagnostics Enabling Agent automatically selects these 
hardware devices for testing.

✎ The Remote Diagnostics Enabling Agent only works if Diagnostics for Windows is installed. 
 
The Remote Diagnostics Enabling Agent is pre-loaded on some computers and is available 
through a SoftPaq at http://www.hp.com under Support and Drivers.

2.6.1 Installing/Upgrading Remote Diagnostics Enabling Agent 
1. Visit http://www.hp.com/support/files and select the applicable product.

2. Locate the appropriate software and download the latest version. 

3. Execute the downloaded file. If you are upgrading an existing version, select Repair for the 
new version to overwrite the old version.

2.6.2 Running the Remote Diagnostics Enabling Agent
1. Select the Remote Diagnostics icon located in the Control Panel.

✎ The Remote Diagnostics Enabling Agent allows you to run Diagnostic Test or the Configuration 
Record in a browser window. You can run both of these utilities remotely or locally.

2. To exit Remote Diagnostics, on the File menu, click Close.

2.7 Protecting the Software
To protect software from loss or damage, you should keep a backup copy of all system software, 
applications, and related files stored on the hard drive. See the operating system or backup utility 
documentation for instructions about making backup copies of data files.

2.8 Restoring the Software 
You can restore the Windows operating system and software to its original state using the 
Restore CD. See the Restore CD for complete instructions.
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Desktop Management

HP Intelligent Manageability provides standards-based solutions for managing and controlling 
desktops, workstations, and notebook PCs in a networked environment. 

The key capabilities and features of desktop management are:

■ Initial configuration and deployment

■ Remote system installation

■ Software updating and management

■ ROM flash

■ Asset tracking and security

■ Fault notification and recovery

✎ Support for specific features described in this guide may vary by model or software version.

3.1 Initial Configuration and Deployment
HP computers come with a preinstalled system software image. After a brief software 
“unbundling” process, the computer is ready for use.

You can deploy a customized software image by: 

■ Installing additional software applications after unbundling the preinstalled software image.

■ Using software deployment tools, such as Altiris Deployment SolutionsTM, to replace the 
preinstalled software with a customized software image.

■ Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends upon your information technology environment and 
processes. The PC Deployment section of the Solutions and Services Web site 
(http://h18000.www1.hp.com/solutions/pcsolutions) provides information to help you select the 
best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with 
recovery of system software, configuration management and troubleshooting, and power 
management.
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3.2 Remote System Installation
Remote System Installation allows you to start and set up your system using the software and 
configuration information located on a network server by initiating the Preboot Execution 
Environment (PXE). The Remote System Installation feature is usually used as a system setup 
and configuration tool, and can be used for the following tasks:

■ Formatting a hard drive.

■ Deploying a software image on one or more new PCs.

■ Remotely updating the system BIOS in flash ROM. See Section 3.4.1, “Remote ROM 
Flash.”

■ Configuring the system BIOS settings.

To initiate Remote System Installation, press F12 when the F12 = Network Service Boot 
message appears in the lower-right corner of the HP logo screen. Follow the instructions on the 
screen to continue the process. The default boot order is a BIOS configuration setting that you 
can change to always attempt to PXE boot.

3.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops and workstations— 
HP Client Manager Software, Altiris Client Management Solution; System Software Manager; 
HP Proactive Notification; and ActiveUpdate.

3.3.1 HP Client Manager Software
HP Client Manager Software (HP CMS) tightly integrates HP Intelligent Manageability 
technology within Altiris to provide superior hardware management capabilities for HP access 
devices that include:

■ Detailed views of hardware inventory for asset management

■ PC health check monitoring and diagnostics

■ Proactive notification of changes in your hardware environment

■ Web-accessible reporting of business critical details such as machines with thermal 
warnings, memory alerts, and more

■ Remote updating of system software such as device drivers and ROM BIOS

■ Remote changing of boot order

■ System BIOS setting configuration

For more information on the HP Client Manager, visit 
http://h18000/www1.hp.com/im/client_mgr.html.
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3.3.2 Altiris Client Management Solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management 
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the 
foundation for additional Altiris Client Management Solutions that address:

■ Inventory and Asset Management

❏ SW license compliance

❏ PC tracking and reporting

❏ Lease contract, fixing asset tracking

■ Deployment and Migration

❏ Windows 2000/XP migration

❏ System deployment

❏ Personality migrations

■ Help Desk and Problem Resolution

❏ Managing help desk tickets

❏ Remote troubleshooting

❏ Remote problem resolution

❏ Client disaster recovery

■ Software and Operations Management

❏ Ongoing desktop management

❏ HP system SW deployment

❏ Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation 
version of the Altiris solutions, visit http://h18000.www1.hp.com/im/prodinfo.html#deploy.

On selected desktop and notebook models, an Altiris management agent is included as part of the 
factory-loaded image. This agent enables communication with the Altiris Development Solution, 
which you can use to complete new hardware deployment or personality migration to a new 
operating system using easy-to-follow wizards. Altiris solutions provide easy-to-use software 
distribution capabilities. When used in conjunction with System Software Manager, or HP Client 
Manager Software, administrators can also update ROM BIOS and device driver software from a 
central console.

For more information, visit http://www.hp.com/go/easydeploy.

3.3.3 System Software Manager
System Software Manager (SSM) lets you update system-level software on multiple systems 
simultaneously. When executed on a PC client system, SSM detects both hardware and software 
versions, then updates the appropriate software from a central repository, also known as a file 
store. Driver versions supported by SSM are denoted with a special icon on the driver download 
Web site and on the Support Software CD. To download the utility or to obtain more information 
on SSM, visit http://h18000.www1.hp.com/im/ssmwp.html.
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3.3.4 Proactive Change Notification (PCN)
The Proactive Change Notification program uses the Subscriber's Choice Web site to proactively 
and automatically send you:

■ Proactive Change Notification (PCN) emails informing you of hardware and software 
changes to most commercial computers and servers, up to 60 days in advance.

■ E-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security 
Bulletins, and Driver alerts for most commercial computers and servers.

You create your own profile to ensure that you only receive the information relevant to your IT 
environment. To learn more about the Proactive Change Notification program and create your 
custom profile, visit http://www.hp.com/go/pcn.

3.3.5 Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you 
with personalized product tips, feature articles, and/or driver and support alerts/notifications. 
Subscriber’s Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you 
that the information you subscribed to in your profile is available for review and retrieval. To 
learn more about Subscriber’s Choice and create a custom profile, visit 
http://www.hp.com/go/pcn.

3.4 ROM Flash
The computer comes with a reprogrammable flash ROM (read only memory). By establishing a 
setup password in Computer Setup (F10) Utility, you can protect the ROM from unintentional 
updates or overwrites. This protection is important to ensure the operating integrity of the 
computer. Should you need or want to upgrade your ROM, you may:

■ Order an upgraded ROMPaq™ diskette from HP.

■ Download the latest ROMPaq images from http://www.hp.com/support/files.

Ä
CAUTION: For maximum ROM protection, establish a setup password. The setup password prevents 
unauthorized ROM upgrades. System Software Manager allows the system administrator to set the setup 
password on one or more PCs simultaneously. For more information, visit 
http://www.hp.com/go/ssm.

3.4.1 Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
computers directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely on multiple computers and personal computers 
results in a consistent deployment of and greater control over HP PC ROM images over the 
network. 

✎ The computer must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or 
System Software Manager at http://h18000.www1.hp.com/im/prodinfo.html.
3–4 361685-001 Service Reference Guide, dx5150

http://h30046.www3.hp.com/subhub.php
http://www.hp.com/united-states/subscribe/
http://h30046.www3.hp.com/subhub.php?jumpid=go/pcn
http://www.hp.com/support/files
http://www.hp.com/go/ssm
http://h18000.www1.hp.com/im/prodinfo.html


Desktop Management
3.4.2 HPQ Flash
Use the HPQFlash utility to locally update or restore the system ROM in individual PCs through 
a Windows environment. For more information on HPQFlash, refer to the HP Client Manager 
Software or System Software Manager at http://www.hp.com/support/files.

3.4.3 FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash 
failure, for example, if a power failure occurs during a ROM upgrade. The Boot Block is a 
flash-protected section of the ROM that checks for a valid system ROM flash when power to the 
system is turned on.

■ If the system ROM is valid, the system starts normally.

■ If the system ROM fails the validation check, the FailSafe Boot Block ROM provides 
enough support to start the system from a ROMPaq diskette, which programs the system 
ROM with a valid image.

✎ Some models also support recovery from a ROMPaq CD.

When the bootblock detects an invalid system ROM, the System Power LED blinks RED eight 
times, one every second, followed by a two-second pause. You will also hear eight simultaneous 
beeps. A Boot Block recovery mode message is displayed on the screen (some models). 

✎ The beeps continue through five cycles of eight simultaneous beeps and stop; however, the LED 
continues blinking until the issue is resolved.

To recover the system after it enters Boot Block recovery mode, complete the following steps:

1. If there is a diskette or a CD in the computer, remove the media and turn off the power.

2. Insert a ROMPaq diskette, bootable drive key, or CD.

3. Turn on power to the system.

4. If no ROMPaq diskette is found, you must insert one and restart the computer.

3.4.4 Replicating Your Setup
To replicate or copy one setup configuration to other computers of the same model, HP has 
provided a Windows-based software utility, System Software Manager, that you can download 
from http://www.hp.com/go/ssm, plus a DOS-based software, CMOS Save/Load utility, that 
can be downloaded from http://www.hp.com/support/files. After logging on to the HP Support 
Web site, enter the name of your computer when prompted.

Creating a Bootable Device

Supported USB Flash Media Device

Supported devices, such as an HP Drive Key, have a pre-installed image to simplify the process 
of making them bootable. If the USB flash media device being used does not have this image, use 
the procedure later in this section (see “Unsupported USB Flash Media Device” on page 7).
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Ä
CAUTION: You cannot boot all computers from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, you can boot the computer 
from a USB flash media device. Otherwise, you must use a bootable diskette.

To create a bootable USB flash media device, you must have a:

■ Supported USB flash media device.

■ Bootable DOS diskette with the FDISK and SYS programs. If SYS is not available, you can 
use FORMAT, but you will lose all existing files on the USB flash media device.

■ PC that is bootable from a USB flash media device.

1. Turn off the computer.

2. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives.

3. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

4. Run FDISK from the A:\ prompt by typing FDISK and pressing Enter. If prompted, click 
Yes (Y) to enable large disk support.

5. Enter Choice [5] to display the drives in the system. The USB flash media device is the drive 
that closely matches the size of one of the drives listed. It is usually the last drive in the list. 
Note the letter of the drive.

USB flash media device drive: __________

Ä
CAUTION: If a drive does not match the USB flash media device, do not proceed. Data loss may occur. 
Check all USB ports for additional storage devices. If any are found, remove them, reboot the computer, 
and proceed from step 4. If none are found, either the system does not support the USB flash media 
device or the USB flash media device is defective. DO NOT proceed in attempting to make the USB flash 
media device bootable.

6. Exit FDISK by pressing the Esc key to return to the A:\ prompt.

7. If your bootable DOS diskette contains SYS.COM, go to step 8. Otherwise, go to step 9.

8. At the A:\ prompt, enter SYS x: where x represents the drive letter noted above.

Ä
CAUTION: Make sure that you have entered the correct drive letter for the USB flash media device.

After transferring the system files, SYS will return to the A:\ prompt. Go to step 13.

9. Copy any files you want to keep from your USB flash media device to a temporary directory 
on another drive (for example, the system's internal hard drive).

10. At the A:\ prompt, enter FORMAT /S X: where X represents the drive letter noted before.

Ä
CAUTION: Make sure that you have entered the correct drive letter for the USB flash media device.

FORMAT will display one or more warnings and ask you each time whether you want to 
proceed. Enter Y each time. FORMAT will format the USB flash media device, add the 
system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.
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12. Copy any files you saved in step 9 back to your USB flash media device.

13. Remove the diskette and reboot the computer. The computer will boot to the USB flash 
media device as drive C.

✎ The default boot order varies from computer to computer, and you can change it in the Computer 
Setup (F10) Utility. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

Unsupported USB Flash Media Device

Ä
CAUTION: You cannot boot all computers from a USB flash media device. If the default boot order in 
the Computer Setup (F10) Utility lists the USB device before the hard drive, you can boot the computer 
from a USB flash media device. Otherwise, you must use a bootable diskette.

To create a bootable USB flash media device, you must have a:

■ Supported USB flash media device.

■ Bootable DOS diskette with the FDISK and SYS programs. If SYS is not available, you can 
use FORMAT, but you will lose all existing files on the USB flash media device.

■ PC that is bootable from a USB flash media device.

1. If there are any PCI cards in the system that have SCSI, ATA RAID or SATA drives attached, 
turn off the computer and unplug the power cord.

Ä
CAUTION: You must unplug the power cord.

2. Open the computer and remove the PCI cards.

3. Insert the USB flash media device into one of the computer's USB ports and remove all other 
USB storage devices except USB diskette drives. Close the computer cover.

4. Plug in the power cord and turn on the computer.

5. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

6. Go to Integrated Peripherals > South OnChip IDE Device to disable the PATA controller, 
and go to Integrated Peripherals > South OnChip PCI Device to disable the SATA 
controller. Exit setup, confirming the changes.

7. Insert a bootable DOS diskette with FDISK.COM and either SYS.COM or FORMAT.COM 
into a diskette drive and turn on the computer to boot to the DOS diskette.

8. Run FDISK and delete any existing partitions on the USB flash media device. Create a new 
partition and mark it active. Exit FDISK by pressing the Esc key.
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9. If the system did not automatically restart when exiting FDISK, press Ctrl+Alt+Del to 
reboot to the DOS diskette.

10. At the A:\ prompt, type FORMAT C: /S and press Enter. Format will format the USB flash 
media device, add the system files, and ask for a Volume Label.

11. Press Enter for no label or enter one if desired.

12. Turn off the computer and unplug the power cord. Open the computer and re-install any PCI 
cards that were previously removed. Close the computer cover.

13. Plug in the power cord, remove the diskette, and turn on the computer.

14. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

15. Go to Integrated Peripherals > South OnChip IDE Device and Integrated Peripherals > 
South OnChip PCI Device and re-enable the PATA and SATA controllers that were disabled 
in step 6. 

16. Save the changes and exit. The computer will boot to the USB flash media device as drive C.

✎ The default boot order varies from computer to computer, and you can change it in the Computer 
Setup (F10) Utility. Refer to the Computer Setup Guide on the Documentation CD for 
instructions. 
 
If you have used a DOS version from Windows 9x, you may see a brief Windows logo screen. If 
you do not want this screen, add a zero-length file named LOGO.SYS to the root directory of the 
USB flash media device.

3.4.5 Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled for Windows XP, the power 
button can function either as an on/off switch or as a suspend button. The suspend feature does 
not completely turn off power, but instead causes the computer to enter a low-power standby. 
This allows you to quickly power down without closing applications and to quickly return to the 
same operational state without any data loss.

To change the power button’s configuration, complete the following steps:

1. Left click on the Start Button, then select Control Panel > Performance and 
Maintenance > Power Options.

2. In the Power Options Properties, select the Advanced tab.

3. In the Power Button section, select Standby.

After configuring the power button to function as a suspend button, press the power button to put 
the system in a very low power state (standby). Press the button again to quickly bring the system 
out of suspend to full power status. To completely turn off all power to the system, press and hold 
the power button for four seconds.

Ä
CAUTION: Do not use the power button to turn off the computer unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.
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3.4.6 World Wide Web Site
When making the transition to new or revised operating systems, it is important to implement the 
support software designed for that operating system. If you plan to run a version of Microsoft 
Windows that is different from the version included with your computer, you must install 
corresponding device drivers and utilities to ensure that all features are supported and 
functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support. The Web site contains 
the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft 
Windows operating system on your HP computer.

3.4.7 Building Blocks and Partners
HP management solutions integrate with other systems management applications, and are based 
on industry standards, such as:

■ Web-Based Enterprise Management (WBEM)

■ Windows Management Interface (WMI)

■ Wake on LAN Technology

■ ACPI

■ SMBIOS

■ Pre-boot Execution (PXE) support

3.5 Asset Tracking and Security
Asset tracking features incorporated into the computer provide key asset tracking data that you 
can manage using HP Insight Manager, HP Client Manager or other system management 
applications. Seamless, automatic integration between asset tracking features and these products 
enables you to choose the management tool that is best suited to your environment and to 
leverage your investment in existing tools. 

HP also offers several solutions for controlling access to valuable components and information. 
ProtectTools Imbeds Security, if installed, prevents unauthorized access to the internal 
components of the personal computer. By disabling parallel, serial, or USB ports, or by disabling 
removable media boot capability, you can protect valuable data assets. You can automatically 
forward Memory Change and Smart Cover Sensor alerts to system management applications to 
deliver proactive notification of tampering with a computer’s internal components.

✎ ProtectTools is available on some systems.

Use the following utilities to manage security settings on your HP computer:

■ Locally, using the Computer Setup Utilities. See the Computer Setup (F10) Utility Guide on 
the Documentation CD included with the computer for additional information and 
instructions on using the Computer Setup Utilities.

■ Remotely, using HP Client Manager or System Software Manager. This software enables the 
secure, consistent deployment and control of security settings from a simple command-line 
utility.
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The following table and sections refer to managing security features of your computer locally 
through the Computer Setup Utilities (F10). 

Security Features Overview
Option Description

Supervisor 
Password

Allows you to set and enable Supervisor (administrator) password.

✎ If the Supervisor password is set, it is required to change Computer Setup 
options, flash the ROM, and make changes to certain plug and play settings 
under Windows.

See the Troubleshooting Guide on the Documentation CD for more information.

User 
Password

Allows you to set and enable a User password.

✎ If the User password is set, it is required to access the computer when power is 
turned on.

See the Troubleshooting Guide on the Documentation CD for more information.

Device 
Security

Enables/disables serial ports, parallel port, front USB ports, system audio, and 
network controllers (some models).

Network 
Service Boot

Enables/disables the computer’s ability to boot from an operating system 
installed on a network server. (Feature available on NIC models only; the 
network controller must reside on the PCI bus or be embedded on the system 
board.)

System IDs Allows you to set:
• Asset tag (18-byte identifier) and ownership Tag (80-byte identifier 

displayed during POST).
• Chassis serial number or Universal Unique Identifier (UUID) number. The 

UUID can only be updated if the current chassis serial number is invalid. 
(These ID numbers are normally set in the factory and are used to uniquely 
identify the system.)

Keyboard locale setting (for example, English or German) for System ID entry.

Master Boot 
Record 
Security

Allows you to enable or disable Master Boot Record (MBR) Security.
When enabled, the BIOS rejects all requests to write to the MBR on the current 
bootable disk. Each time the computer is powered on or rebooted, the BIOS 
compares the MBR of the current bootable disk to the previously-saved MBR. If 
changes are detected, you are given the option of saving the MBR on the 
current bootable disk, restoring the previously-saved MBR, or disabling MBR 
Security. You must know the setup password, if one is set.

✎ Disable MBR Security before intentionally changing the formatting or 
partitioning of the current bootable disk. Several disk utilities (such as FDISK 
and FORMAT) attempt to update the MBR.
If MBR Security is enabled and disk accesses are being serviced by the BIOS, 
write requests to the MBR are rejected, causing the utilities to report errors.

If MBR Security is enabled and disk accesses are being serviced by the operating 
system, any MBR change will be detected by the BIOS during the next reboot, and an 
MBR Security warning message will be displayed.

✎ For more information about Computer Setup, see the Computer Setup (F10) Utility Guide on the 
Documentation CD.
Support for security features may vary depending on the specific computer configuration.
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3.5.1 Password Security
The user password prevents unauthorized use of the computer by requiring entry of a password to 
access applications or data each time the computer is turned on or restarted. The setup password 
specifically prevents unauthorized access to Computer Setup, and can also be used as an override 
to the user password. That is, when prompted for the user password, entering the supervisor 
password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to 
all network systems to perform maintenance without having to know the user password, even if 
one has been established.

✎ System Software Manager and HP Client Manager Software allow remote management of Setup 
Passwords and other BIOS settings in a networked environment. For more information, visit 
http://www.hp.com/go/EasyDeploy.

3.5.2 Establishing a Supervisor Password with Computer Setup
If the system is equipped with an embedded security device, refer to HP ProtectTools Embedded 
Security Guide, on the Documentation CD. Establishing a Supervisor password through 
Computer Setup prevents reconfiguration of the computer (use of the Computer Setup F10 
utility) until the password is entered.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Set Security Password and follow the instructions on the screen.

4. Before exiting, on the File menu, select Save Changes and Exit.

3.5.3 Establishing a User Password with Computer Setup
Establishing a user password through Computer Setup prevents access to the computer when 
power is turned on unless the password is entered. When a user password is set, Computer Setup 
presents Password Options under the Security menu. Password options include Password Prompt 
on Warm Boot. When Password Prompt on Warm Boot is enabled, you must also enter the 
password each time the computer is rebooted. 

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.
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3. Select Security, then Power-On Password and follow the instructions on the screen.

4. Before exiting, on the File menu, select Save Changes and Exit.

Entering a User Password
To enter a power-on password, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart. 

2. When the key icon appears on the monitor, type your current password, then press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, the message “Invalid Password, Press any key to continue!” 
appears. Try again. After three unsuccessful tries, you must turn off the computer, then turn it on 
again before you can continue.

Entering a Supervisor Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Embedded Security Guide, on the Documentation CD.

If a Supervisor password has been established on the computer, you will be prompted to enter it 
each time you run Computer Setup.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. When the Enter Password box appears on the monitor, type the supervisor password, then 
press Enter.

✎ Type carefully; for security reasons, the characters you type do not appear on the screen.

If you enter the password incorrectly, the message “Invalid Password, Press any key to continue!” 
appears. Try again. After three unsuccessful tries, you must turn off the computer, then turn it on 
again before you can continue.
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Changing a User or Supervisor Password
If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Embedded Security Guide, on the Documentation CD.

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart 
the Computer. 

2. When the Enter Password box appears, type the current User password, if a password is 
required.

3. Press Enter.

4. Press and hold the F10 key until you enter Computer Setup. Press Enter to bypass the title 
screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

5. When the Enter Password box appears to access Computer Setup, type the current 
Supervisor password, if required.

6. Press Enter.

7. Select either Set Supervisor Password or Set User Password.

8. When the Enter Password box appears on the screen, type the new password and press 
Enter.

9. Before exiting, on the File menu, select Save Changes and Exit.

✎ To delete a password instead of changing it, when the Enter Password box appears on the 
screen, press Enter instead of entering the new password. This deletes the current password.

Clearing Passwords 
If you forget the password, you cannot access the computer. Refer to the Troubleshooting Guide 
on the Documentation CD for instructions on clearing passwords.

If the system is equipped with an embedded security device, refer to the HP ProtectTools 
Embedded Security Guide, on the Documentation CD.

3.5.4 Master Boot Record Security
The Master Boot Record (MBR) contains information needed to successfully boot from a disk 
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional 
or malicious changes to the MBR, such as those caused by some computer viruses or by the 
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR, 
should the computer detect changes to the MBR when the system is restarted.

To enable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.
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✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Advanced BIOS Features > MBR Security and press Enter.

4. In the MBR Security box, press the up or down arrows to select Enabled or Disabled. 

5. To accept the changes, press Enter. To abort the changes, press the Esc key. 

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the 
current bootable disk while in MS-DOS or Windows Safe Mode. 

✎ Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running.

Each time the computer is turned on or restarted, the BIOS compares the MBR of the current 
bootable disk to the previously saved MBR. If changes are detected and if the current bootable 
disk is the same disk from which the MBR was previously saved, the following message is 
displayed:

1999—Master Boot Record has changed.
1. Press any key to enter Setup to configure MBR Security.

2. Upon entering Computer Setup, you must disable the MBR Security feature.

You must know the supervisor password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR 
was previously saved, the following message is displayed:

2000—Master Boot Record Hard Drive has changed.
1. Press any key to enter Setup to configure MBR Security.

2. Upon entering Computer Setup, you must disable the MBR Security feature.

You must know the supervisor password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998—Master Boot Record has been lost.
1. Press any key to enter Setup to configure MBR Security.

2. Upon entering Computer Setup, you must disable the MBR Security feature.

You must know the supervisor password, if one exists.
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3.5.5 Before You Partition or Format the Current Bootable Disk
Ensure that MBR Security is disabled before you change partitioning or formatting of the current 
bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update the MBR. If 
MBR Security is enabled when you change partitioning or formatting of the disk, you may 
receive error messages from the disk utility or a warning from MBR Security the next time the 
computer is turned on or restarted. 

To disable MBR Security, complete the following steps:

1. Turn on or restart the computer. If you are in Windows, click Start > Shut Down > Restart.

2. As soon as the computer is turned on, press and hold the F10 key until you enter Computer 
Setup. Press Enter to bypass the title screen, if necessary.

✎ If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility. 
 
If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3. Select Advanced BIOS Features > MBR Security and press Enter. 

4. In the MBR Security Pop-up box, use the down arrow key to select Disabled. 

5. Press Enter.

6. Before exiting, on the File menu, click Save and Exit Setup. 

3.5.6 Cable Lock Provision
The rear panel of the computer accommodates a cable lock so that you can physically secure the 
computer to a work area.

For illustrated instructions, see the Removal and Replacement Chapter for the specific chassis.

3.6 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology 
to prevent the loss of critical data and minimize unplanned downtime.

When a fault occurs, the computer displays a Local Alert message containing a description of the 
fault and any recommended actions. You can then view current system health by using the HP 
Client Manager Software. If the computer is connected to a network managed by HP Insight 
Manager, HP Client Manager Software, or other system management applications, the computer 
also sends a fault notice to the network management application.

3.6.1 Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the computer is hit 
with an unpredictable power surge. This power supply is rated to withstand a power surge of up 
to 2000 volts without incurring any system downtime or data loss.

3.6.2 Thermal Sensor
The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
computer. This feature displays a warning message when the normal range is exceeded, which 
gives you time to take action before internal components are damaged or data is lost.
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4
Serial and Parallel ATA Drive 

Guidelines and Features

✎ Serial ATA = SATA 
Parallel ATA = PATA

Ä
CAUTION: HP only supports a PATA hard drive in SATA systems when the PATA hard drive is used in 
a MultiBay device.

4.1 SATA Hard Drive Information

SATA connectors on the system board are color coded to make identification easier.

4.1.1 SATA Data Cable
The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive. As 
shown in the table, each cable has three grounds, and four transmit/receive pins.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and 
never bend it tighter than a 30 mm (1.18 in) radius. 

Characteristic SATA

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400 - 700 mV

Drive voltages 3.3 V, 5V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 1.5 Gb/s

SATA Identification Color

Primary channel, device 0 Blue

Secondary channel, device 0 White 
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4.1.2 SATA Power Cable

4.2 PATA Hard Drive Information

Pin Number Usage Device Plug Host Plug

P1 Ground Ground Ground

P2* A+ Transmit data Receive data

P3* A- Transmit data Receive data

P4 Ground Ground Ground

P5** B- Receive data Transmit data

P6** B+ Receive data Transmit data

P7 Ground Ground Ground

*P2 and P3 differential signal pair
**P5 and P6 differential signal pair

Pin Usage Notes Pin Usage Notes

P1 V3.3 3.3 V power P9 V5 5 V power

P2 V3.3 3.3 V power P10 Ground

P3 V3.3 3.3 V power P11 Reserved

P4 Ground P12 Ground

P5 Ground P13 V 12 12 V power

P6 Ground P14 V12 12 V power

P7 V5 5 V power P15 V12 12 V power

P8 V5 5 V power

Characteristic PATA

Number of pins/conductors in data cable 40/80

Number of pins in power cable 4

Maximum data cable length 18 in (45.7 cm)

Data interface voltage 5 V

Drive voltages 5 V, 12 V

Jumpers for configuring drive Required

Data transfer rate up to 1.0 Gb/s
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4.2.1 PATA Data Cable

4.2.2 PATA Power Cable

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
 

Pin Usage

1 +12 V

2 Ground

3 Ground

4 +5 V
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4.2.3 PATA Cable Layout
The faces of industry-standard cable connectors are color-coded for easy recognition:

■ System board connector = blue face

■ Device 0 connector = black face

■ Device 1 connector = gray face

✎ The color code of an industry-standard cable is applicable only if the drive’s jumper is in the 
cable-select position.

Single-Drive Cable

Two-Drive Cable

On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system 
board connector and the Drive/Device 1 connector is always the closest to the system board 
connector. 

✎ Some cables may be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of 
“Device 1”. 

4.3 PATA Drive Installation Guidelines

Ä
CAUTION: HP only supports a PATA hard drive in SATA systems when the PATA hard drive is used in 
a MultiBay device.

This computer system board has one Parallel ATA (PATA) channel. 

The channel can have up to two devices attached to it. All drives are connected to a channel 
using an industry-standard 80-conductor cable.

✎ The industry standard 1.44 MB diskette drive has its own separate channel and is not included as 
a part of the maximum four drives.

System 
Board

Device 0

Black 
Face

Blue 
Face

System 
Board

Device 1 Device 0

Black 
Face

Blue 
Face

Gray 
Face
4–4 361685-001 Service Reference Guide, dx5150



Serial and Parallel ATA Drive Guidelines and Features
The drive attached to a channel must have a drive designation. If a drive is attached to the 
Device 0 cable position and its cable-select jumper is present, the drive is designated as Device 
0. Similarly, if a drive is attached to the Device 1 cable position and its cable-select jumper is 
present, the drive is designated as Device 1.

For optimal performance of a computer system, all drives need to be attached to the PATA 
channel(s) in a specified sequence. This sequence is determined by the device class of the drives 
and by specific attach sequence rules.

4.3.1 PATA Device Classes
To determine the best drive attach sequence, ATA/ATAPI drives are segregated into four 
different classes based upon the bandwidth demands they place on an ATA channel. The most 
demanding devices are in Class 1 and the least demanding are in Class 4.

General Attach Guidelines
■ The lower the device class number, the faster the device and the more bandwidth required.

■ A drive installed in the Device 0 position receives the greatest possible bandwidth.

4.4 ATA SMART Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP 
Personal Computers have built-in drive failure prediction that warns the user or network 
administrator of an impending failure or crash of the hard drive. The SMART drive tracks fault 
prediction and failure indication parameters such as reallocated sector count, spin retry count, 
and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.

4.5 Drive Capacities
The combination of the file system and the operating system used in the computer determines the 
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that 
the operating system can properly access. Therefore, a single hard drive can be subdivided into a 
number of unique drive partitions in order to make use of all of its space. 

Because of the differences in the way that drive sizes are calculated, the size reported by the 
operating system may differ from that marked on the hard drive or listed in the computer 
specification. Drive size calculations by drive manufacturers are bytes to the base 10 while 
calculations by Microsoft are bytes to the base 2.

Class 1 
Hard
Drives

Class 2 
High Speed 

Optical Drives

Class 3
Optical Storage 

Drives

Class 4
Magnetic 

Storage Drives

Only MultiBay 
hard drive is 
supported

DVD 
DVD-CD R/W

R/W CD-ROM  
CD-ROM 

Zip 
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4.6 SATA BIOS

4.6.1 Legacy Mode
Use Legacy mode to access devices attached to the embedded IDE controller. The channel 
requires two fixed I/O address ranges and an IRQ for each.

❏ Command block: 1F0h - 1F7h

❏ Control block: 3F6h

❏ IRQ: 14

Drive/Partition Capacity Limits

Maximum Size

File 
System

Controller 
Type Operating System

 
Partition Drive 

FAT 32 ATA Windows 2000/ XP 32 GB 128 PB

NTFS ATA Windows NT/2000/XP 2 TB 128 PB

Windows 2000 and XP Windows 9x, NT, and Linux

Enhanced Mode (default BIOS Setting) 
—Separate IDE controller

Compatibility Mode (non-default BIOS Setting) 
—Combined IDE controller

• PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of 
PATA controller’s Primary Channel 
- Device 1 is accessible as Device 1 of 
PATA controller’s Primary Channel

• SATA Controller in Native Mode 
- SATA 0 is accessible as Device 0 of 
SATA controller’s Primary Channel 
- SATA 1 is accessible as Device 0 of 
SATA controller’s Secondary Channel 
SATA 2 is accessible as Device 1 of SATA 
controller’s Primary Channel 
- SATA 3 is accessible as Device 1 of 
SATA controller’s Secondary Channel

• PATA Controller in Legacy Mode 
- Device 0 is accessible as Device 0 of the 
combined controller’s Secondary Channel 
- Device 1 is accessible as Device 1 of the 
combined controller’s Secondary Channel

• SATA Controller in Legacy Mode 
- SATA 0 is accessible as Device 0 of the 
combined controller’s Primary Channel 
- SATA 1 is inaccessible 
- SATA 2 is accessible as device 1 of the 
combined controller’s Primary Channel 
- SATA 3 is inaccessible
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4.6.2 Native Mode
Use Native mode to access devices attached to add-in cards. Native mode is not supported by 
many legacy operating systems. PCI Plug-n-Play BIOS assigns addresses and the IRQ is shared 
with multiple controllers. The PCI Configuration Space contains Base Address Registers for the 
Command and Control Block.

■ Offset 10h—Primary Command base address

■ Offset 14h—Primary Control base address

■ Offset 18h—Secondary Command base address

■ Offset 1Ch—Secondary Control base address

4.7 Mixed Devices Boot and Drive Letter Ordering

SATA Emulation Hard Drive Order
HDD Boot and Drive 

Letter Ordering

Separate IDE Controller 
(default). Used with Windows 
2000 and XP.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
A3. SATA 1 
A4. SATA 3
B1. IDE Device 0
B2. IDE Device 1

Separate IDE Controller. 
Used with Windows 2000 
and XP.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0
B2. SATA 2
B3. SATA 1
B4. SATA 3

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated SATA
B. Integrated IDE

A1. SATA 0 
A2. SATA 2
B1. IDE Device 0
B2. IDE Device 1

Combined with IDE 
Controller. Used with 
Windows 9x, NT, and Linux.

A. Integrated IDE
B. Integrated SATA

A1. IDE Device 0
A2. IDE Device 1
B1. SATA 0 
B2. SATA 2
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5
Identifying the Chassis, Routine Care, and 

Disassembly Preparation

This chapter provides general service information. To properly service the computer, you must 
adhere to the procedures and precautions described in this chapter.

Ä
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the 
system board. You must disconnect the power cord from the power source before opening the computer 
to prevent system board or component damage. 

✎ Not all models are available in all chassis styles.

5.1 Chassis Designations

5.1.1 Microtower (MT) 
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5.1.2 Small Form Factor (SFF)

5.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy 
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage 
occurs. An electronic device exposed to electrostatic discharge (ESD) may not appear to be 
affected at all and can work perfectly throughout a normal cycle. The device may function 
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the 
discharge contains enough power to alter device parameters or melt silicon junctions.
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5.2.1 Generating Static
The following table shows that:

■ Different activities generate different amounts of static electricity. 

■ Static electricity increases as humidity decreases. 

✎ 700 volts can degrade a product.

5.2.2 Preventing Electrostatic Damage to Equipment 
Many electronic components are sensitive to ESD. Circuitry design and structure determine the 
degree of sensitivity. The following packaging and grounding precautions are necessary to 
prevent damage to electric components and accessories.

■ To avoid hand contact, transport products in static-safe containers such as tubes, bags, or 
boxes.

■ Protect all electrostatic parts and assemblies with conductive or approved containers or 
packaging.

■ Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Avoid contact with pins, leads, or circuitry.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
conductive foam.

5.2.3 Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

■ Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the 
ground cords. To provide proper ground, you must wear a strap snug against bare skin. The 
ground cord must be connected and fit snugly into the banana plug connector on the 
grounding mat or workstation.

Relative Humidity

Event 55% 40% 10%

Walking across carpet 
Walking across vinyl floor 
Motions of bench worker 
Removing DIPs* from plastic tube

7,500 V 
3,000 V 

400 V 
400 V

15,000 V 
5,000 V 

800 V 
700 V

35,000 V 
12,000 V 
6,000 V 
2,000 V

Removing DIPs* from vinyl tray 
Removing DIPs* from Styrofoam 
Removing bubble pack from PCB 
Packing PCBs in foam-lined box

2,000 V 
3,500 V 
7,000 V 
5,000 V

4,000 V 
5,000 V 

20,000 V 
11,000 V

11,500 V 
14,500 V 
26,500 V 
21,000 V

*These components are multi-packaged inside plastic tubes, trays, or Styrofoam.
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■ Heel straps/Toe straps/Boot straps can be used at standing workstations and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, 
use them on both feet with a maximum of one-megohm ± 10% resistance between the 
operator and ground.

5.2.4 Grounding the Work Area
To prevent static damage at the work area, use the following precautions:

■ Cover the work surface with approved static-dissipative material. Provide a wrist strap 
connected to the work surface and properly grounded tools and equipment.

■ Use static-dissipative mats, foot straps, or air ionizers to give added protection.

■ Handle electrostatic sensitive components, parts, and assemblies by the case or PCB 
laminate. Handle them only at static-free work areas.

■ Turn off power and input signals before inserting and removing connectors or test 
equipment.

■ Use fixtures made of static-safe materials when fixtures must directly contact dissipative 
surfaces.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

5.2.5 Recommended Materials and Equipment
Materials and equipment recommended for use in preventing static electricity include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

■ Wrist straps and footwear straps providing one-megohm +/- 10% resistance

■ Material handling packages

■ Conductive plastic bags

■ Conductive plastic tubes

Static Shielding Protection Levels

Method Voltage

Antistatic plastic 
Carbon-loaded plastic 
Metallized laminate

1,500 
7,500 

15,000
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■ Conductive tote boxes

■ Opaque shielding bags

■ Transparent metallized shielding bags

■ Transparent shielding tubes

5.3 Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

■ Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and 
cold.

■ Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all 
vented sides of the computer and above the monitor to permit the required airflow.

■ Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place 
the keyboard, with the keyboard feet down, directly against the front of the desktop unit as 
this also restricts airflow.

■ Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other 
foreign matter can block the vents and limit the airflow.

■ Never operate the computer with the cover or side panel removed.

■ Do not stack computers on top of each other or place computers so near each other that they 
are subject to each other’s re-circulated or preheated air.

■ If the computer is to be operated within a separate enclosure, intake and exhaust ventilation 
must be provided on the enclosure, and the same operating guidelines listed above will still 
apply.

■ The computer is designed to operate continuously (24x7), provided that the operating 
guidelines listed above are met.

■ Install or enable power management functions of the operating system or other software, 
including sleep states.

5.4 Routine Care

5.4.1 General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth 
and then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.
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5.4.2 Cleaning the Computer Case
Follow all safety precautions in Section 5.4.1, “General Cleaning Safety Precautions,” before 
cleaning the computer.

To clean the computer case, follow the procedures described below:

■ To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

■ For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it 
with a cloth or swab dampened with clear water.

■ For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

■ After cleaning, always wipe the unit with a clean, lint-free cloth.

■ Occasionally clean the air vents on the computer. Lint and other foreign matter can block the 
vents and limit the airflow.

5.4.3 Cleaning the Keyboard
Follow all safety precautions in Section 5.4.1, “General Cleaning Safety Precautions,” before 
cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in  
Section 5.4.2, “Cleaning the Computer Case.”

When cleaning debris from under the keys, review all rules in Section 5.4.1, “General Cleaning 
Safety Precautions,” before following these procedures:

Ä
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys.

■ You may remove visible debris underneath or between the keys by vacuuming or shaking.

■ You may use canned, pressurized air to clean debris from under the keys. Use caution, as too 
much air pressure can dislodge lubricants applied under the wide keys.

■ If you remove a key, use a specially designed key puller to prevent damage to the keys. This 
tool is available through many electronic supply outlets.

Ä
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard may not function properly.

■ Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be 
careful not to wipe away lubricants necessary for proper key functions. Use tweezers to 
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

5.4.4 Cleaning the Monitor
■ Wipe the monitor screen with a clean cloth moistened with water or with a towelette 

designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the 
liquid may seep into the housing and damage a component. Never use solvents or flammable 
liquids on the monitor.

■ To clean the monitor body, follow the procedures in Section 5.4.2, “Cleaning the Computer 
Case.”
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5.4.5 Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

■ Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull 
out any debris from the ball socket and wipe the ball with a clean, dry cloth before 
reassembly. 

■ To clean the mouse body, follow the procedures in Section 5.4, “Routine Care.”

5.5 Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly 
and assembly of the computer.

5.5.1 Power Supply Fan
The power supply fan is a variable-speed fan based on the temperature in the power supply.

Ä
CAUTION: The cooling fan is always on when the computer is either in the “On,” “Standby,” or 
“Suspend” modes. The cooling fan of off when the computer is in “Standby,” “Suspend,” or “OFF” 
modes. 
You must disconnect the power cord from the power source before opening the computer to prevent 
system board or component damage.

5.5.2 Tools and Software Requirements
To service the computer, you need the following:

■ Torx T-15 screwdriver (Compaq screwdriver with bits, PN 161946-001)

■ Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

■ Flat-bladed screwdriver (may sometimes use in place of the Torx screwdriver)

■ Phillips #2 screwdriver

■ Diagnostics software

■ Compaq tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or 
Compaq tamper-resistant bits (Smart Cover FailSafe Key, PN 166527-002)

5.5.3 Screws
The screws used in the computer are not interchangeable. They may have standard or metric 
threads and may be of different lengths. If an incorrect screw is used during the reassembly 
process, the screw can damage the unit. HP strongly recommends that you keep all screws 
removed during disassembly with the part that was removed, then returned to their proper 
locations.

✎ Metric screws have a black finish. 
U.S. screws have a silver finish and are used only for the hard drive.

✎ As you remove each subassembly from the computer, place the subassembly away from the work 
area to prevent damage.
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5.5.4 Cables and Connectors
Most cables used in the unit are flat, flexible cables. You just handle these cables with care to 
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or 
removal from the connector. Handle cables by the connector whenever possible. In all cases, 
avoid bending or twisting the cables, and ensure that the cables are routed in such a way that they 
cannot be caught or snagged by parts being removed or replaced.

Ä
CAUTION: When servicing this computer, ensure that you place cables in their proper location during 
the reassembly process. Improper cable placement can damage the computer.

5.5.5 Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. 
This applies to failed drives as well as replacement spares.

■ If you must mail a drive, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

■ Do not remove hard drives from the shipping package for storage. Keep hard drives in their 
protective packaging until they are mounted in the CPU.

■ Avoid dropping drives from any height onto any surface.

■ If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard 
drive while the computer is on or in standby mode.

■ Before handling a drive, discharge yourself of static electricity. While handling a drive, 
avoid touching the connector. For more information about preventing electrostatic damage, 
refer to Section 5.2, “Electrostatic Discharge Information.”

■ Do not use excessive force when inserting a drive.

■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic 
fields, such as monitors or speakers.
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5.5.6 Lithium Coin Cell Battery
The battery that comes with the computer provides power to the real-time clock and has a 
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this 
guide for replacement procedures.

Å
WARNING: This computer contains a lithium battery. There is a risk of fire and chemical burns if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 60ºC (140ºF). 

Ä
CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the 
general household waste. 
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Removal and Replacement Procedures— 

Microtower (MT) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

6.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 6.2.1, 
“Installing a Cable Lock,” and Section 6.2.2, “Installing a Padlock”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems, the cooling fan is on even when the 
computer is in the “Standby” or “Suspend” mode. Always disconnect the power cord before servicing a 
unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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6.2 External Security Devices

6.2.1 Installing a Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 

6.2.2 Installing a Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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6.3 Access Panel 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Loosen the captive thumbscrew 1 that secures the access panel to the computer chassis. 

3. Slide the access panel 2 back about 2.5 cm (1 inch), then lift it off the unit.

✎ You may want to lay the computer on its side to install internal parts. Make sure the side with the 
access panel and pull grip is facing up.

To install the access panel, reverse the removal procedure.
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6.4 Front Bezel 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel (Section 6.3, “Access Panel”).

3. To remove the front bezel, press in on the two bottom tabs on the side of the bezel 1 so that 
they release from the chassis. Then press in on the upper tab on the side of the bezel so that it 
releases from the chassis. The bezel will rotate out slightly 2.

To reinstall the front bezel,

1. Position the chassis in the upright position. 

2. Insert the two hooks on the right side of the bezel 1 into the rectangular holes on the chassis 
then rotate the bezel into place 2 so that the three tabs on the left side of the bezel and the 
single tab on the upper right corner of the bezel snap into the slots on the chassis.
6–4 361685-001 Service Reference Guide, dx5150



Removal and Replacement Procedures— Microtower (MT) Chassis
6.5 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel (Section 6.3, “Access Panel”).

3. Remove the front bezel (Section 6.4, “Front Bezel”)

6.5.1 5.25" Drive Bezel Blank 
Press the two retaining tabs on the inside of the large bezel 1 towards the outside of the bezel to 
release the bezel blank. At the same time, pull the bezel blank in 2 to remove it from the front 
bezel. 

To install a bezel blank, reverse the removal procedure.
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6.5.2 Diskette Drive Bezel 
Press the two upper 1 or the two lower 2 tabs for the diskette drive bezel towards the center of 
the drive bezel and push the bezel out to remove it from the front bezel.

To install a bezel or a bezel blank, reverse the removal procedure.

6.5.3 3.5" Drive Bezel Blank 
Press the two upper 1 or the two lower 2 tabs for the 3.5" drive bezel towards the center of the 
3.5" drive bezel and push the bezel blank out to remove it from the front bezel.

To install a bezel blank, reverse the removal procedure.
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6.6 Cable Management 
Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure on them.

■ Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the 
parts are moved.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.

■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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6.6.1 Cable Connections

Cable To Cable Designator

Power Supply System board P1

Power Supply System board P5

Power Supply 1st SATA Hard drive P7

Power Supply 2nd SATA Hard drive P6

Power Supply 1st Optical drive P2

Power Supply 2nd Optical drive P3

Power Supply Diskette drive P4

Power Supply 5.25” Zip drive P3

Cable To PCA Designator

Diskette drive System board FDD1 (Black) 

1st SATA Hard drive System board SATA 1 (Blue)

2nd SATA Hard drive System board SATA 2 (White)

ODD Data System board IDE1 (Blue)

ODD Audio (if required) System board CD_IN1 (Black)

2nd ODD Audio (if required) System board AUX_IN1 (Yellow)

Heatsink fan System board CPU_FAN

Secondary system fan System board CHASSIS_FAN

Front LED power on button System board F_P1

Front I/O USB System board JUSB1 (Yellow)

Front I/O Audio System board AUD1 (Black)

Speaker System board SPKR

Serial port connector System board COM1

TCIP Security module System board JTPM1
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6.7 Memory Modules

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other. 
 
Static electricity can damage the electronic components of the computer or optional cards. Before 
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a 
grounded metal object. Refer to Chapter 5 for more information. 
 
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage 
the module.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”). If you have locked the Smart 
Cover Lock, use Computer Setup to unlock the lock.

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Begin by installing a module into the socket nearest the preinstalled module, and 
install the modules following the numerical order of the sockets.

✎ You can install a memory module in only one way. Match the notch on the module with the tab 
on the memory socket. 

4. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.

5. Repeat steps 3 and 4 for any additional modules that you want to install.

To reassemble the computer, reverse the removal procedure.
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6.8 Expansion Cards 

6.8.1 Expansion Slot Cover 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. On the rear of the computer, remove the retaining screw and slide the slot cover lock up to 
access the expansion slot covers. 

For instructions on PCI expansion cards see Section 6.8.2, “PCI Expansion Card.”
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6.8.2 PCI Expansion Card 
For preliminary steps, see Section 6.8.1, “Expansion Slot Cover.”

1. Lay the computer on its side with the open side facing up.

If replacing a PCI expansion card go to step 2.

If installing a PCI expansion card for the first time in a computer, skip to step 5.

2. When removing an expansion card from a standard expansion socket, hold the card at each 
end, and carefully rock it back and forth until the connectors pull free from the socket. 

3. Pull the expansion card straight up from the socket 1 then away from the inside of the 
chassis 2 to maneuver the card out of the computer. 

Ä
CAUTION: Make sure not to scrape the card against the other components.

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or cover the open 
slot (for example, with a metal slot cover or a piece of cardboard taped in place) for proper cooling of 
internal components during operation.

4. Store the old card in the anti-static packaging that contained the new card.

5. If you are installing a PCI expansion card for the first time in this computer, you will need to 
remove the correct expansion slot cover at this time.
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6. When installing an expansion card, hold the card just above the expansion slot on the system 
board then move the card toward the rear of the chassis so that the bracket on the card is 
aligned with the open slot on the rear of the chassis 1. 

7. Press the card straight down into the expansion slot on the system board 2. 

✎ Press firmly on the card so that the whole connector seats properly in the expansion card slot.

8. Slide the slot cover lock down toward the expansion card brackets and slot covers to secure 
them in place.
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6.9 Drives
The computer supports up to six drives that may be installed in various configurations.

This Section describes the procedure for replacing or upgrading the storage drives. A Torx T-15 
screwdriver is needed to remove and install the guide screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you will need to run the Restore CD to load the factory-installed files.

6.9.1 Drive Positions 

Drive Positions
Item Description Item Description

1 Optical drive* 4 Bay for optional 3.5" drive

2 Second optical drive 5 Primary hard drive

3 Diskette drive (optional) 6 Optional hard drive

* CD-ROM, CD-R/RW, DVD-ROM, DVD-R/RW, or CD-RW/DVD Combo drive.
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6.9.2 Removing a Drive 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front bezel (Section 6.4, “Front Bezel”).

4. Disconnect the audio, data, and power cables from the back of the drive, as shown in the 
following illustrations:

Disconnecting Optical Drive Cables 
Audio cable is 1, data cable is 2, and power cable is 3.
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Disconnecting Diskette Drive Cables 
Data cable is 1 and power cable is 2.

Disconnecting Hard Drive Cables 
Power cable is 1, data cable is 2.
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Releasing the Drives
5. A latch drive bracket with release tabs secures the drives in the drive bay. Lift the release tab 

on the latch drive bracket 1 for the drive you want to remove, then slide the drive from its 
drive bay 2.

6. Remove the four guide screws (two on each side) from the old drive. You will need these 
screws to install a new drive. 
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6.9.3 Installing a Drive 

Ä
CAUTION: To prevent loss of work and damage to the computer or drive:
■ If you are inserting or removing a hard drive, shut down the operating system properly, then turn off 

the computer. Do not remove a hard drive while the computer is on or in standby mode.
■ Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 

avoid touching the connector. For more information about preventing electrostatic damage, refer to 
Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for more 
information

■ Handle a drive carefully; do not drop it.
■ Do not use excessive force when inserting a drive.
■ Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 

such as monitors or speakers.

1. Install four guide screws (two on each side) into the new drive. The screws help guide the 
drive into its proper position in the bay. 

❏ If this is a new installation, guide screws are provided on the front of the chassis under 
the front bezel.

❏ If this is a replacement drive, use the screws taken from the old drive.

✎ There are a total of eight extra guide screws on the front of the chassis. Four have U.S. threads 
and four have metric threads. Metric screws have a black finish. U.S. threaded screws have a 
silver finish and are only used for hard drives. Make sure to install the appropriate guide screws 
into the drive.

2. Align the guide screws with the guide slots, then slide the drive into the drive bay, making 
sure it is fully seated. 
Service Reference Guide, dx5150 361685-001 6–17



Removal and Replacement Procedures— Microtower (MT) Chassis
3. Reconnect all cables to the drive as shown in the following illustrations.

✎ Refer to Chapter 4, Section 4.3, “PATA Drive Installation Guidelines,” for information on 
attaching the cabling to get optimum performance.

Connecting Optical Drive Cables 
Audio cable is 1, data cable is 2, power cable is 3.

Connecting Diskette Drive Cables 
Data cable is 1, power cable is 2.
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Connecting Hard Drive Cables 
Power cable is 1, data cable is 2.

4. Install the front bezel (Section 6.4, “Front Bezel”).

5. Install the access panel (Section 6.3, “Access Panel”).

6. Turn on the computer.

✎ If you replaced the primary hard drive, you may use the restore CD to restore the operating 
system, software drivers, and/or any software applications that were preinstalled on the 
computer. Follow the instructions in the guide included with the restore CD. When the restore 
process has completed, reinstall any personal files that were backed up before replacing the hard 
drive.
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6.10 Chassis Fan 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect the power cable that connects the chassis fan to the system board 1.

4. Remove the four screws from the rear of the chassis 2 that secure the fan. 

5. Remove the fan from the chassis 3.

To install the chassis fan, reverse the removal procedure.
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6.11 Front I/O Panel Housing Assembly 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect the following three attaching cables from the system board:

❏ power switch/LED cable

❏ front USB cable

❏ front audio cable

4. Remove the two screws 1 that secure the housing to the chassis and then pull the housing 2 
away from the chassis.

To install the housing assembly, reverse the removal procedures.
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6.12 Front I/O Devices 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front I/O panel assembly (Section 6.11, “Front I/O Panel Housing Assembly”).

4. Remove the two screws 1 that hold the USB and audio port assembly in place.

5. Remove the I/O device assembly from the I/O panel 2 by pushing it out of the housing.

To install the I/O devices, reverse the removal procedures and then reinstall the housing 
assembly.
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6.13 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the front I/O panel assembly (Section 6.11, “Front I/O Panel Housing Assembly”).

4. Squeeze the switch holder retaining clips together 1 and push the switch assembly out of the 
front I/O panel housing.

5. From the inside of the I/O panel assembly, spread the clips 2 that secure the LEDs in place, 
and then push the LEDs out of the retainers from the front side. 

6. If necessary, compress the retaining clips on the LED holders and push the holders out of the 
front of the I/O panel housing. 

7. Remove the switch from the switch holder 3.

8. To install the power switch assembly install the switch into the switch holder.
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9. Place the switch holder with switch installed into the inside of the front I/O panel housing 
and position the legs of the retaining clip into the clip slots. Press firmly so that the clips will 
penetrate the slot openings and latch into place. If one clip will not easily engage, it may be 
necessary to use the end of a ball point pen (or another thin, stiff object) to compress the clip 
leg while inserting it into the clip slot.

10. Push the LEDs into the their retainers. The power LED (having the blue and black leads) 
should be to the right when viewed from the front of the computer. 

11. Reconnect the housing assembly to the front of the chassis and reconnect the cables to the 
system board.
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6.14 Heatsink 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect the heatsink fan cable 1 from the system board. 

4. Loosen the two screws 2 that secure the heatsink to the processor.

5. Twist the heatsink to break the bond between it and the processor.

6. Lift the heatsink 3 from the processor.

To install a heatsink, reverse the removal procedure.

Ä
CAUTION: Always refresh the thermal grease when reinstalling a heatsink. 
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6.15 Processor 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove the heatsink (Section 6.14, “Heatsink”)

4. Rotate the ZIF socket handle to its fully open position 1.

5. Carefully lift the processor from the socket 2. 

To install a new processor:

1. Insert the processor into the socket.

2. Secure the locking lever.

If reusing the existing heatsink, go to step 3. 

If using a new heatsink, go to step 5. 

3. If reusing the existing heatsink clean bottom of the heatsink and apply the thermal grease 
found in the spares kit to the top of the processor.

4. Clean the bottom of the heatsink with the provided alcohol pad and place it atop the 
processor.

Go to step 6.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the two captive screws 
and attach the heatsink control cable to the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the computer is using the latest version of the BIOS. You can find the latest system ROMPaq 
on the Web at: http://h18000.www1.hp.com/support/files.
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6.16 System Board 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Remove all PCI expansion cards (Section 6.8.2, “PCI Expansion Card”).

4. Remove the memory modules (Section 6.7, “Memory Modules”).

5. Remove the heatsink (Section 6.14, “Heatsink”).

6. Remove the processor (Section 6.15, “Processor”).

7. Disconnect all cables connected to the system board, noting their location for reinstallation.

8. Remove the eight screws that secure the system board to the chassis, then slide the board 
toward the front of the computer until the rear I/O connectors clear the chassis.

ÄCAUTION: When installing a new system board, you must attach a new processor backing 
plate to the system board. The heatsink will not attach properly if this plate is not installed.
Service Reference Guide, dx5150 361685-001 6–27



Removal and Replacement Procedures— Microtower (MT) Chassis
To install a processor backing plate:

1. Lay the new system board top down on a padded surface to protect the board from damage.

2. Remove the protective paper shield 1 from the mounting surface of the backing plate.

3. Position the mounting plate studs over the back of the sytem board 2 and press the plate 
firmly to the system board so the studs penetrate the mounting holes.

To complete the installation of the system board, reverse the removal procedures.
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6.17 Battery
The battery that comes with your computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ You can extend the lifetime of the lithium battery by plugging the computer into a live AC wall 
socket. The computer uses the lithium battery only when NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
chemical burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP/Compaq spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP/Compaq, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1.  Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

✎ You may need to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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6.17.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up. The battery holder automatically 
secures the battery in the proper position.

3. Replace the computer cover or access panel (Section 6.3, “Access Panel”).

4. Plug in and turn on power to the computer.

5. Using Computer Setup, reset the date and time, passwords, and any special system setups. 
For more information, refer to the Computer Setup (F10) Utility Guide.
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6.17.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery 1. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 2 
with the positive side up. Push the other edge down until the clamp snaps over the other edge 
of the battery.

✎ After replacing the battery, use the following steps to complete this procedure.

3. Replace the computer cover or access panel (Section 6.3, “Access Panel”).

4. Plug in and turn on power to the computer.

5. Using Computer Setup, reset the date and time, passwords, and any special system setups. 
For more information, refer to the Computer Setup (F10) Utility Guide.
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6.17.3 Type 3 Battery Holder
1. To release the battery from its holder, press back lever 1 that extends above one edge of the 

battery.

2. When the battery pops up, lift it out 2.

3. To insert the new battery, push it down into the holder with the positive side to the left as 
shown in the drawing above.

4. Replace the computer access panel (Section 6.3, “Access Panel”).

5. Plug in the computer and turn on power.

6. Using Computer Setup, reset the date and time, passwords, and any special system setups. 
For more information, refer to the Computer Setup (F10) Utility Guide.
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6.18 Speaker 
1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Move/remove any components necessary to gain access to the speaker.

4. Disconnect the speaker wire from the system board connector.

5. Remove the two screws 1, that secure the speaker to the chassis.

6. Remove the speaker 2.

To install the speaker, reverse the removal procedures.
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6.19 Power Supply

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment, disconnect the power 
cord from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 6.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 6.3, “Access Panel”).

3. Disconnect all power cables from the mass storage devices and from the system board.

4. Remove the screws that connect the power supply to the chassis 1.

5. Slide the power supply toward the front of the computer, then lift it out of the computer 2.

To install the power supply, reverse the removal procedure.
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Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper 
service. After completing all necessary removal and replacement procedures, run the Diagnostics 
utility to verify that all components operate properly.

✎ Not all features listed in this guide are available on all computers.

7.1 Preparation for Disassembly 
See Chapter 5, “Identifying the Chassis, Routine Care, and Disassembly Preparation,” for initial 
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Section 7.2, 
“External Security Devices”).

2. Close any open software applications.

3. Exit the operating system.

4. Remove any diskette, compact disc, or MultiBay device from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

Ä
CAUTION: Turn off the computer before disconnecting any cables.

Ä
CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. In some systems the cooling fan is on even when the 
computer is in the “Standby” or “Suspend” modes. Always disconnect the power cord before servicing a 
unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

✎ During disassembly, label each cable as you remove it, noting its position and routing. Keep all 
screws with the units removed.

Ä
CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong 
screw in an application may damage the unit.
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7.2 External Security Devices

7.2.1 Cable Lock 
The cable lock may be used to secure the computer access panel to the chassis and, at the same 
time, secure the computer to a fixed object. 

As shown, there are two acceptable methods for using the cable lock. While both methods work, 
for added security, HP recommends that you use the method shown on the left where the cable 
lock penetrates both the access panel and the chassis.
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7.2.2 Padlock 
A padlock may be used by itself to secure the access panel to the computer chassis. A padlock 
may also be used with a security cable to secure the computer to a fixed object.
I
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7.3 Computer Access Panel
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

Ä
CAUTION: Before removing the computer access panel, ensure that the computer is turned off and that 
the power cord is disconnected from the electrical outlet.

2. Pull up and hold open the latch on the top of the computer 1. 

3. Slide the computer access panel 2 back about 1.3 cm (0.5 inch), then lift it off the unit.

When installing the access panel, press down on its center to ensure the latches are properly 
secured while sliding it into the locked position. 
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7.4 Front Bezel 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Pull up on the three release tabs 1 on the top of the bezel, then pull the front bezel away 
from the chassis 2.

To reinstall the front bezel, reverse the removal procedure 
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7.5 Front Drive Bezels 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Press the large retaining tab 1 on the side of the bezel insert as shown then, push the bezel 
insert out of the front bezel 2. 

To install a bezel or a bezel blank, reverse the removal procedure.
7–6 361685-001 Service Reference Guide, dx5150



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.6 Memory Modules

Ä
CAUTION: The memory module sockets have gold metal contacts. When upgrading the memory, it is 
important to use memory modules with gold metal contacts to prevent corrosion and/or oxidation 
resulting from having incompatible metals in contact with each other.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional cards. 
Before beginning these procedures, ensure that you discharge yourself of static electricity by briefly 
touching a grounded metal object. Refer to Chapter 5, “Identifying the Chassis, Routine Care, and 
Disassembly Preparation,” for more information.

Ä
CAUTION: When handling a memory module, be careful not to touch any of the contacts. Doing so 
may damage the module.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

Å
WARNING: To reduce risk of personal injury from hot surfaces, allow the internal system components to 
cool before touching.

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its full upright position.

5. Open both latches of the memory module socket 1, and insert the memory module into the 
socket 2. Begin by installing a module into the socket nearest the preinstalled module, and 
install the modules following the numerical order of the sockets.

✎ A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket. 
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6. Push the module down into the socket, ensuring that the module is fully inserted and 
properly seated. Make sure the latches are in the closed position 3.

7. Repeat steps 4 and 5 for any additional modules that you want to install.

✎ The computer automatically recognizes the additional memory when the computer is turned on.

To reassemble the computer, reverse the removal procedure.

✎ If you normally lock the Smart Cover Lock, use Computer Setup to relock the lock and enable 
the Smart Cover Sensor.

7.7 PCI Expansion Card 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Disconnect all cables attached to the expansion cards.

4. Release the expansion card latch 1 that secures the PCI slot covers by pulling the latch up.

5. If you are installing a card for the first time continue with step 6. 
If you are removing an existing card go to step 7.

6. Remove the slot cover by sliding it up and off 2.
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7. If you are removing an expansion card from a PCI expansion socket, hold the card at each 
end and carefully rock it back and forth until the connectors pull free from the socket. Lift 
the expansion card straight up then pull it in toward the center of the chassis to release it from 
the chassis frame. Make sure not to scrape the card against other components.

8. Place the card under the rear panel bracket 1, then firmly push the expansion card into the 
connector 2. Ensure that the card is firmly seated in the expansion card slot.

✎ Be sure not to touch the rear panel bracket or other components in the chassis when installing an 
expansion card.

9. Push the expansion slot latch down 3 to secure the card.
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✎ If you are not replacing the old expansion card with a new card, install an expansion slot cover to 
close the open slot. Insert the metal slot covering the open slot, then push the expansion slot latch 
down to secure the slot cover in place

Ä
CAUTION: After removing an expansion card, you must replace it with a new card or cover the open 
slot with a metal slot cover or a piece of tape for proper cooling of internal components. Failure to do so 
may cause the system to overheat.

7.8 Drives
The computer supports up to three drives. This section describes the procedure for replacing or 
upgrading the storage drives. You need a Torx T-15 screwdriver to remove and install the guide 
screws on a drive.

Ä
CAUTION: Make sure personal files on the hard drive are backed up to an external storage device 
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary hard 
drive, you need to run the Restore Plus! CD to load the factory-installed files.

7.8.1 Drive Positions 

To verify the type and size of the storage device installed in the computer, run Computer Setup.

Drive Positions
Item Description Item Description

1 One standard 3.5-inch, one-third 
height bay (1.44-MB diskette drive 
shown)*

3 Internal 3.5-inch, one-third height bay 
for hard drive

2 5.25-inch drive bay for optional 
drives.

*If a 1.44-MB diskette drive is installed, it is configured with a diskette drive bezel as shown in 
the illustration. If the computer contains an empty 3.5-inch drive bay, then a bezel blank is 
installed instead. If you do not have a drive in this slot, you may later choose to install a 3.5-inch 
device (such as a diskette drive, hard drive, or Zip drive). However, to install a 3.5-inch device 
other than a diskette drive or hard drive, you must order the 3.5-inch device bezel to provide 
proper air flow within the chassis.
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7.8.2 Cable Management

Ä
CAUTION: You must keep the drive data and power cables clear of the power supply and the power 
supply fan to avoid damage or restrict air flow.

Follow these guidelines when routing the cables in the computer:

1. Route the optical drive audio cable 1 (if needed) along the back of the optical drive and then 
down, alongside of the drive cage to the floor of the chassis. Route this cable behind the hard 
drive data cable. 

2. Route the optical drive power cable 2 down, alongside of the drive cage to the floor of the 
chassis. Keep the cable clear of the power supply fan.

3. Fold the diskette drive flat-ribbon data cable 3 near the connector on the drive. Route the 
cable up high on the drive cage (near the cable connectors), then folding again to lay beneath 
the optical drive data cable. 

4. The cable clip 4 is stamped from the back of the drive cage and secures the diskette drive 
power cable.

Always follow good cable management practices when working inside the computer.

■ Keep cables away from major heat sources like the heatsink.

■ Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like 
these are not designed to take excessive pressure.

■ Keep cables clear of sliding or moveable parts to prevent their being cut or crimped when the 
parts are moved.

■ When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the 
wires.

■ Some flat ribbon cables come prefolded. Never change the folds on these cables.

■ Do not bend any cable sharply. A sharp bend can break the internal wires.
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■ Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius. 

■ Never crease a SATA data cable.

■ Do not rely on components like the drive cage, power supply, or computer cover to push 
cables down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the P1 or P3 connectors on the system 
board, always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector 1.

2. Grasp the cable end of the connector and pull it straight up 2.

Ä
CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could damage the 
cable and result in a failed power supply.
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7.8.3 Cable Connections

Cable To Cable Designator

Power Supply System board (ATX1) P1

Power Supply System board (JPW1) P2

Power Supply 1st SATA Hard drive P5

Power Supply 2nd SATA Hard drive P3

Power Supply Optical drive P6

Power Supply Diskette drive P4

Power Supply 5.25” Zip drive P6

Cable To PCA Designator

Diskette drive System board FDD1 (Black) 

ODD Data System board IDE1 (Blue)

ODD Audio (if required) System board CD_IN1 (Black)

Heatsink fan System board CPU_FAN

Secondary system fan System board CHASSIS_FAN

Front LED power on button System board F_P1

Front I/O USB System board JUSB1 (Yellow)

Front I/O Audio System board AUD1 (Black)

Speaker System board SPKR

Serial port connector System board COM1

1st SATA Hard drive System board SATA 1 (Blue)

2nd SATA Hard drive System board SATA 2 (White)

TCIP Security module System board JTPM1
Service Reference Guide, dx5150 361685-001 7–13



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.8.4 Optical Drive 

Ä
CAUTION: Remove all media from the drives before removing the drive from the computer.

✎ An optical drive is a CD-ROM, CD-RW, DVD-ROM, or combination CD/DVD drive.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Raise the Easy Access drive cage to the upright position.

5. Disconnect the audio, signal, and drive power cables from the drive. The other end of the 
cables should remain connected to the system board.

6. Make sure you properly route the drive cables (Section 7.8.2, “Cable Management”).

7. Return the Easy Access drive cage to the down position.

8. Push the drive release latch 1 toward the rear of the chassis and hold.

9. Slide the drive 2 toward the front of the drive cage, then lift the drive out of the computer.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
To replace the drive:

1. Install two guide screws in the lower holes on each side of the drive. 

Ä
CAUTION: Use only 5-mm long screws as guide screws. Longer screws can damage the internal 
components of the drive.

✎ When replacing the drive, transfer the four screws from the old drive to the new one. The screws 
take the place of drive rails.

2. Position the guide screws on the drive into the J-slots in the drive bay 1. Then, slide the drive 
towards the rear of the computer 2.

✎ The drive release latch automatically locks in place when installing a drive.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
3. Raise the Easy Access drive cage to the upright position and connect the flat ribbon cable 
and audio cable to the system board.

4. Connect the following cables to the rear of the optical drive:

❏ Audio cable 1

❏ Flat ribbon data cable 2

❏ Power cable 3

✎ Windows XP does not require the use of an audio cable to transfer the sound to the system board.

5. Make sure you route the drive cables properly (Section 7.8.2, “Cable Management”).

6. Return the Easy Access drive cage to the down position. Make sure not to pinch the cables in 
the chassis when lowering the Easy Access drive cage.

7. Replace the front bezel and computer access panel.

The system automatically recognizes the drive and reconfigures the computer.

Ä
CAUTION: When servicing the computer, make sure you place cables in their proper locations during 
the reassembly process. Improper cable placement can damage the computer.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.8.5 External 3.5-inch Drive 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”). 

3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Raise the Easy Access drive cage to the upright position.

5. Disconnect the signal, and drive power cables from the drive. The other end of the cables 
should remain connected to the system board.

6. Return the Easy Access drive cage to the down position.

7. Push the drive release latch 1 toward the rear of the chassis and hold.

8. Slide the drive 2 toward the front of the drive cage, then lift the drive out of the computer.

✎ When replacing the drive, transfer the four screws from the old drive to the new one. The screws 
take the place of drive rails.

✎ The guide screws on a 3.5-inch diskette drive 1 are placed closer together than on the hard 
drive 2.

9. Insert the rear screws of the hard drive into the rear J-slots. Slide the drive toward the back of 
the drive cage until the front screws are aligned with the front J-slots. Then lower the front of 
the drive. Continue to slide the drive all the way back until it locks into place.

✎ If replacing a diskette drive, all guide screws (front and rear) will line up on the J-slots. Insert the 
guide screws into the J-slots, then slide the drive toward the back of the drive cage until it locks 
into place.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
10. Connect the power and data cables.

11. Make sure the drive cables are routed properly (Section 7.8.2, “Cable Management”).

12. Rotate the drive cage to its original position.

13. Replace the front bezel and computer access panel.
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7.8.6 Primary Hard Drive 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”). 

3. Remove the front bezel (Section 7.4, “Front Bezel”).

4. Raise the Easy Access drive cage to the upright position.

5. Disconnect the power cable 1 and signal cable 2 from the back of the drive.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
6. Press and hold the drive release latch 1.

7. Slide the drive to the right of the bay 2, then pull the drive from the bay 3.

To replace the hard drive, reverse the above procedure.

✎ When replacing the hard drive, transfer the four screws from the old drive to the new one. The 
screws take the place of drive rails. You will need a Torx T-15 screwdriver to remove and 
re-install the guide screws.

Make sure you route the drive cables properly (Section 7.8.2, “Cable Management”) before 
rotating the drive cage to its original position.
7–20 361685-001 Service Reference Guide, dx5150



Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.9 Front I/O Devices 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the front bezel (Section 7.4, “Front Bezel,”).

3. Rotate the drive cage to its full open position.

4. Disconnect the two I/O device cables from the system board:

❏ front USB cable pair

❏ front audio cable

5. Remove the power supply from the chassis (Section 7.17, “Power Supply”).

6. From the inside of the chassis, remove the two screws that secure the I/O device to the 
chassis 1, then pull the device into the chassis 2 to free it from its mount. 

✎ You may need a stubby Torx T15 screwdriver to remove the retaining screws.

To install the housing assembly, reverse the removal procedures.
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7.10 Power Switch Assembly 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the front bezel (Section 7.4, “Front Bezel,”).

3. Rotate the drive cage to its full open position.

4. Disconnect the power switch/LED cable from the system board. 

5. Squeeze the switch holder retaining clips together at the front of the chassis 1 and push the 
switch assembly out of the chassis 2.

To install the power switch assembly, reverse the removal procedure. 
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7.11 Speaker 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its upright position.

5. Disconnect the speaker wire from the system board.

6. Remove the two screws that secure the speaker to the chassis 1.

✎ You may need a stubby Torx T15 screwdriver to access the screws.

7. Remove the speaker 2.

To install the speaker, reverse the removal procedures.
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7.12 Chassis Fan 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its full open position.

5. Disconnect the fan cable from the system board.

6. Remove the four screws that secure the fan grill and the fan to the chassis 2, then pull the fan 
out of the chassis 3.

✎ You may need a stubby Torx T15 screwdriver to remove the retaining screws.

.

To install the chassis fan, reverse the removal procedure. 
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7.13 Battery
The battery that comes with this computer provides power to the real-time clock and has a 
lifetime of about three years. When replacing the battery, use a battery equivalent to the battery 
originally installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

✎ The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall 
socket. The lithium battery is only used when the computer is NOT connected to AC power.

Å
WARNING: This computer contains an internal lithium manganese dioxide battery. There is a risk of fire and 
chemical burns if the battery is not handled properly. To reduce the risk of personal injury:
■ Do not attempt to recharge the battery.
■ Do not expose to temperatures higher than 140°F (60°C) 
■ Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or 

water.
■ Replace the battery only with the HP/Compaq spare designated for this product.

Ä
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings. When 
the battery is removed or replaced, the CMOS settings will be cleared. Refer to the Troubleshooting 
Guide for information on backing up the CMOS settings.

N
Batteries, battery packs, and accumulators should not be disposed of together with the general 
household waste. In order to forward them to recycling or proper disposal, please use the public 
collection system or return them to HP/Compaq, their authorized partners, or their agents.

Ä
CAUTION: Static electricity can damage the electronic components of the computer or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

✎ You may have to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Carefully pull the cable bundle out of the way to access the battery.

5. Depending on the type of battery holder on your system board, complete the following 
instructions to replace the battery:
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.13.1 Type 1 Battery Holder
1. Lift the battery out of its holder.

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer cover or access panel.

5. Plug in and turn on power to the computer.

6. Using Computer Setup, reset the date and time, passwords, and any special system setups. 
For more information, refer to the Computer Setup (F10) Utility Guide.
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7.13.2 Type 2 Battery Holder
1. To release the battery from its holder, squeeze the metal clamp that extends above one edge 

of the battery 1. When the battery pops up, lift it out.

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip 2 
with the positive side up. Push the other edge down until the clamp snaps over the other edge 
of the battery.

✎ After replacing the battery, use the following steps to complete this procedure.

3. Replace the computer cover or access panel.

4. Plug in and turn on power to the computer.

5. Using Computer Setup, reset the date and time, passwords, and any special system setups. 
For more information, refer to the Computer Setup (F10) Utility Guide.
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7.14 Heatsink Assembly
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its full open position.

5. Disconnect the heatsink fan control cable from the system board.

6. Loosen the two captive screws 1 that secure the heatsink to the system board.

✎ You will need a straight shanked, flat blade, or Torx T15 screwdriver to loosen the heatsink 
retaining screws.

7. Twist the heatsink slightly to break the bond between it and the processor then, lift the 
heatsink from the processor 2

8. Set the heatsink on its side to keep the thermal grease from getting on the work surface.

✎ If reinstalling this heatsink, make sure that you clean its mounting surface and the mounting 
surface of the processor with an alcohol pad then, apply a fresh coating of thermal grease to the 
top of the processor. 

Ä
CAUTION: Failure to apply a fresh coating of thermal grease could cause the computer to overheat.
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Removal and Replacement Procedures— Small Form Factor (SFF) Chassis
7.15 Processor
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Remove the heatsink (Section 7.14, “Heatsink Assembly”)

5. Rotate the socket handle to its fully open position 1.

6. Carefully lift the processor from the socket 3. 

To install a new processor:

1. Insert the processor into the socket.

2. Secure the locking lever. 

If reusing the existing heatsink, go to step 3. 

If using a new heatsink, go to step 5.

3. If reusing the existing heatsink clean bottom of the heatsink and apply the thermal grease 
provided in the spares kit to the top of the processor.

4. Clean the bottom of the heatsink with the provided alcohol pad and place it atop the 
processor.

Go to step 6.

5. If using a new heatsink, remove the protective covering from the bottom of the heatsink and 
place it in position atop the processor.

6. Secure the heatsink to the system board and system board tray with the two captive screws 
and attach the heatsink control cable to the system board.

✎ After installing a new processor onto the system board, always update the system ROM to ensure 
that the computer is using the latest version of the BIOS. You can find the latest system ROMPaq 
on the Web at: http://h18000.www1.hp.com/support/files.
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7.16 System Board 
1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the access panel and rotate the computer so the system board is parallel to the table 
to make it easier to work on (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its full open position.

5. Remove all expansion cards (Section 7.7, “PCI Expansion Card”).

6. Remove the memory modules (Section 7.6, “Memory Modules”).

7. Remove the heatsink (Section 7.14, “Heatsink Assembly”).

8. Remove the processor (Section 7.15, “Processor”).

9. Disconnect all cables connected to the system board, noting their location for reinstallation.

10. Remove the eight screws that secure the system board to the chassis.

11. Slide the board towards the front of the computer for the rear I/O connectors to clear the 
chassis then, remove the system board from the chassis.

ÄCAUTION: When installing a new system board, a new processor backing plate must be 
attached to the system board. The heatsink will not attach properly if this plate is not 
installed.
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To install a processor backing plate:

1. Lay the new system board top down on a padded surface to protect the board from damage.

2. Remove the protective paper shield 1 from the mounting surface of the backing plate.

3. Position the mounting plate studs over the back of the system board 2 and press the plate 
firmly to the system board so the studs penetrate the mounting holes.

Complete the installation of the system board by reversing the removal procedures.
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7.17 Power Supply 

Å
WARNING: Voltage is always present on the system board when the computer is plugged into an 
active AC outlet. To avoid possible personal injury and damage to the equipment, disconnect the power 
cord from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Section 7.1, “Preparation for Disassembly”).

2. Remove the computer access panel (Section 7.3, “Computer Access Panel”).

3. Remove the front bezel (Section 7.4, “Front Bezel,”).

4. Rotate the drive cage to its upright position.

5. Disconnect all power cables from the mass storage devices and from the system board.

6. Remove the TPM from the system board to prevent damaging it.

7. Remove the three screws that secure the power supply to the chassis 1. 

8. Slide the power supply forward about 3/8-inch, lift it to clear the guides on the floor of the 
chassis 2 then, pivot the top of the power supply 3 to clear the top chassis lip.

When installing the power supply, reverse the removal procedure, making sure that the clips on 
the bottom of the rear panel fit in the slots provided.
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A
Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. 
Some of these connectors may not be used on the product being serviced.

Keyboard
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Mouse
Connector and Icon Pin Signal

1 
2 
3

Data 
Unused 
Ground

4 
5 
6

+5 VDC 
Clock 
Unused

Ethernet BNC
Connector and Icon Pin Signal

1 (Center) Data

2 (Shield) Ground
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Connector Pin Assignments
Ethernet RJ-45
Connector and Icon Pin Signal

1 
2 
3 
4

(+) Transmit Data 
(-) Transmit Data 
(+) Receive Data 
Unused

5 
6 
7 
8

Unused 
(-) Receive Data 
Unused 
Unused

Ethernet AUI

Connector and Icon

Pin Signal Pin Signal

1 
2 
3 
4

Ground 
Negative AUI Differential Collision 
Positive AUI Differential Collision 
Negative AUI Differential Transmit

9 
10 
11 
12

Positive AUI Differential Receive 
+12V 
Ground 
Ground

5 
6 
7 
8

Positive AUI Differential Transmit 
Ground 
Ground 
Negative AUI Differential Receive

13 
14 
15 
16

Unused 
Unused 
Unused 
Unused

Parallel Interface

Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Strobe 
Data Bit 0 
Data Bit 1

7 
8 
9

Data Bit 5 
Data Bit 6 
Data Bit 7

13 
14 
15

Select 
Auto Linefeed 
Error

4 
5 
6

Data Bit 2 
Data Bit 3 
Data Bit 4

10 
11 
12

Acknowledge 
Busy 
Paper End

16 
17 
18-25

Initialize Printer 
Select IN 
Signal Ground
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Connector Pin Assignments
Serial Interface, Powered and Non-Powered
Connector and Icon Pin Signal

1 
2 
3

Carrier Detect (12V if powered) 
Receive Data 
Transmit Data

4 
5 
6

Data Terminal Ready 
Signal Ground 
Data Set Ready

7 
8 
9

Request to Send 
Clear to Send 
Ring Indicator (5V if powered)

USB
Connector and Icon Pin Signal

1 
2 
3 
4

+5 VDC 
- Data 
+ Data 
Ground

Microphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio

2 (Ring) Power

3 (Shield) Ground

Headphone
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Left

2 (Ring) Audio_Right

3 (Shield) Ground

Line-In Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_In_Left

2 (Ring) Audio_In_Right

3 (Shield) Ground

1 2 3

1 2 3

1 2 3
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Line-Out Audio
Connector and Icon (1/8” miniphone) Pin Signal

1 (Tip) Audio_Out_Left

2 (Ring) Audio_Out_Right

3 (Shield) Ground

SCSI Low Voltage Differential/Single Ended (LVD/SE)
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-16 
17-18 
19

Ground 
TERMPWR 
Reserved

40 
41 
42

-D0 
-D1 
-D1

49-50 
51-52 
53

Ground 
TERMPW 
Reserved

60 
61 
62

-MSG 
-SEL 
-C/D

20-34 
35 
36

Ground 
-D12 
-D13

43 
44 
45

-D3 
-D4 
-D5

54 
55 
56

Ground 
-ATN 
Ground

63 
64 
65

-REQ 
-I/O 
-D

37 
38 
39

-D14 
-D15 
-DP1

46 
47 
48

-D6 
-D7 
-DP0

57 
58 
59

-BSY 
-ACK 
-RST

66 
67 
68

-D 
-D 
-D

1 2 3

Ultra SCSI
Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1-11 
12 
13 
14

Ground 
Reserved 
Open 
Reserved

29 
30 
31 
32

DB3 
DB4 
DB5 
DB6

37 
38 
39 
40

Reserved 
TERMPWR 
Reserved 
Ground

45 
46 
47 
48

RST # 
MSG # 
SEL # 
C/D

15-25 
26 
27 
28

Ground 
DB0 
DB1 
DB2

33 
34 
35 
36

DB7 
DBP 
Ground 
Ground

41 
42 
43 
44

ATN # 
Ground 
BSY # 
ACK #

49 
50

REQ # 
Input/Output
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External Infrared Transceiver
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Transmit 
Receive 
Ground

4 
5 
6

5V 
Mode 
Not Used

7 
8 

Not Used 
Not Used

Monitor
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3

Red Analog 
Green Analog 
Blue Analog

6 
7 
8

Ground 
Ground 
Ground

11 
12 
13

Not used 
DDC Serial Data 
Horizontal Sync

4 
5

Not used 
Ground

9 
10

+5V (fused) 
Ground

14 
15

Vertical Sync 
DDC Serial Clock

DVI-D
Connector and Icon

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4

TMDS Data2- 
TMDS Data2+ 
TMDS Data2/4 Shield 
TMDS Data4-

9 
10 
11 
12

TMDS Data1- 
TMDS Data1+ 
TMDS Data1/3Shield 
TMDS Data3-

17 
18 
19 
20

TMDS Data0- 
TMDS Data0+ 
TMDS Data0/5 Shield 
TMDS Data5-

5 
6 
7 
8

TMDS Data4+ 
DDC Clock 
DDC Data 
No Connect

13 
14 
15 
16

TMDS Data3+ 
+5V Power 
Grd for +5V 
Hot Plug Detect

21 
22 
23 
24

TMDS Data5+ 
TMDS Data Clock 
Shield 
TMDS Clock+ 
TMDS Clock-
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Connector Pin Assignments
ATA/ATAPI (IDE) Standard Drive Cable
Connector

Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

Reset 
Ground 
DD7 
DD8 
DD6

15 
16 
17 
18 
19

DD1 
DD14 
DD0 
DD15 
Ground

29 
30 
31 
32 
33

DMAK 
Ground 
INTRQ 
IOCS16 
DA1

6 
7 
8 
9 
10

DD9 
DD5 
DD10 
DD4 
DD11

20 
21 
22 
23 
24

(Key) 
DMARQ 
Ground 
DIOW 
Ground

34 
35 
36 
37 
38

PDIAG (cable detect) 
DA0 
DA2 
CS1FX 
CS3FX

11 
12 
13 
14

DD3 
DD12 
DD2 
DD13

25 
26 
27 
28

DIOR 
Ground 
IORDY 
CSEL

39 
40 
 

DASP 
Ground 
 

24-Pin Power
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+3.3 V 
+3.3 V 
GND 
+5 V 
GND 
+5 V

7 
8 
9 
10 
11 
12

GND 
POK 
+5 Vaux 
+12 V 
+12 V 
+3.34 V

13 
14 
15 
16 
17 
18

+3.34 V 
-12 V 
GND 
PSON 
GND 
GND

19 
20 
21 
22 
23 
24

GND 
open 
+5 V 
+5 V 
+5 V 
GND

24

12

13

1
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Connector Pin Assignments
 

24-Pin MicroFit Power
Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5 
6

+5 Vaux 
GND
+5 V 
+5 V 
PS_ON 
GND

7 
8 
9 
10 
11 
12

PWRGD
+3.3 V 
+3.3 V 
Tach 
GND 
Fan-CMD

13 
14 
15 
16 
17 
18

+12 V 
+5 V Sense 
GND 
+5 V 
+5 V 
+3.3 V

19 
20 
21 
22 
23 
24

GND 
+3.3 Sense 
+3.3 V 
+3.3 V 
GND 
-12 V

4-Pin Power (for CPU)
Connector and Icon Pin Signal

1 GND

2 GND

3 +12 V CPU

4 -12 V CPU

24

12

13�

1

SATA Data and Power 

Drive Connector

Pin Signal Pin Signal Pin Signal Pin Signal

S1
S5

Ground
B-

S2
S6

A+
B+

S3
S7

A-
Ground

S4 Ground

P1
P5
P9
P13

V 3.3
Ground
V 5
V 12

P2
P6
P10
P14

V 3.3
Ground
Ground
V 12

P3
P7
P11
P15

V 3.3
V 5
Reserved
V 12

P4
P8
P12

Ground
V 5
Ground

*S = Data, P = Power
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PCI Express 
x1, x4, x8, and x16 PCI Express Connector

Pin A

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

PRSNT1# 
+12V 
+12V 
GND 
JTAG2

6 
7 
8 
9 
10

JTAG3 
JTAG4 
JTAG5 
+3.3v 
+3.3v

11 
12 
13 
14 
15

PERST# 
GND 
REFCLK+ 
REFCLK- 
GND

16 
17 
18 
19 
20

PERp0 
PERn0 
GND 
RSVD 
GND

21 
22 
23 
24 
25

PERp1 
PERn1 
GND 
GND 
PERp2

26 
27 
28 
29 
30

PERn(2) 
GND 
GND 
PERp3 
PERn3

31 
32 
33 
34 
35

GND 
RSVD 
RSVD 
GND 
PERp4

36 
37 
38 
39 
40

PERn4 
GND 
GND 
PERp5 
PERn5

41 
42 
43 
44 
45

GND 
GND 
PERp6
PERn6 
GND

46 
47 
48 
49 
50

GND 
PERp7 
PERn7 
GND 
RSVD

51 
52 
53 
54 
55

GND 
PERp8 
PERn8 
GND 
GND

56 
57 
58 
59 
60

PERp9 
PERn9 
GND 
GND 
PERp10

61
62 
63 
64 
65

PERn10 
GND 
GND 
PERp11 
PERn11

66 
67 
68 
69 
70

GND 
GND 
PERp12 
PERn12 
GND

71 
72 
73 
74 
75

GND 
PERp13 
PERn13 
GND 
GND

76 
77 
78 
79 
80

PERp14 
PERn14 
GND 
GND 
PERp15

81 
82

PERn15 
GND

Pin B information is on the next page

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82 
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Connector Pin Assignments
Pin B

Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal

1 
2 
3 
4 
5

+12V 
+12V 
RSVD 
GND 
SMCLK

6 
7 
8 
9 
10

SMDAT 
GND 
+3.3v 
JTAG1 
3.3vAux

11 
12 
13 
14 
15

WAKE# 
RSVD 
GND 
PETp0 
PETn0

16 
17 
18 
19 
20

GND 
PRSNT2# 
GND 
PETp1 
PETn1

21 
22 
23 
24 
25

GND 
GND 
PETp2 
PETn2 
GND

26 
27 
28 
29 
30

GND 
PETp3 
PETn3 
GND
RSVD

31 
32 
33 
34 
35

PRSNT2# 
GND 
PETp4 
PETn4 
GND

36 
37 
38 
39 
40

GND 
PETp5 
PETn5 
GND 
GND

41 
42 
43 
44 
45

PETp6 
PRTn6 
GND 
GND 
PETp7

46 
47 
48 
49 
50

PETn7 
GND 
PRSNT2# 
GND 
PETp8

51 
52 
53 
54 
55

PETn8 
GND 
GND 
PETp9 
PETn9

56 
57 
58 
59 
60

GND 
GND 
PETp10 
PETn10 
GND

61 
62 
63 
64 
65

GND 
PETp11 
PETn11 
GND 
GND

66 
67 
68 
69 
70

PETp12 
PETn12 
GND 
GND 
PETp13

71 
72 
73 
74 
75

PETn13 
GND 
GND 
PETp14 
PETn14

76 
77 
78 
79 
80

GND 
GND 
PETp15 
PETn15 
GND

81 
82

PRSNT2# 
RSVD

Notes: 
x1 PCI Express uses pins 1-18 
x4 PCI Express uses pins 1-32 
x8 PCI Express uses pins 1-49 
x16 PCI Express uses pins 1-82

PCI Express 
x1, x4, x8, and x16 PCI Express Connector
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B
Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch 
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 
volts AC. Power supplies on those computers that do not have external power switches are 
equipped with internal switches that sense the incoming voltage and automatically switch to the 
proper voltage.

The power cord set received with the computer meets the requirements for use in the country 
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you 
use the computer.

General Requirements
The requirements listed below are applicable to all countries: 

1. The power cord must be approved by an acceptable accredited agency responsible for 
evaluation in the country where the power cord set will be installed. 

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a 
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system. 

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the 
cord must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items 
placed upon it or against it. Particular attention should be paid to the plug, electrical outlet, and 
the point where the cord exits from the product.

Å
WARNING: Do not operate this product with a damaged power cord set. If the power cord set is 
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

Ä
CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country
Accrediting

Agency Country
Accrediting

Agency

Australia (1) 
Austria (1) 
Belgium (1)  
Canada (2)

EANSW 
OVE 
CEBC 
CSA

Italy (1) 
Japan (3) 
Norway (1) 
Sweden (1)

IMQ 
METI 
NEMKO 
SEMKO

Denmark (1) 
Finland (1)  
France (1)  
Germany (1) 

DEMKO 
SETI 
UTE 
VDE

Switzerland (1) 
United Kingdom (1) 
United States (2) 

SEV 
BSI 
UL 

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear the certification mark of 
the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug 
must be a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P 
(15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration 
number in accordance with the Japanese Dentori Law. Flexible cord must be Type VCT or 
VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole grounding type 
with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C
POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible 
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the 
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count 
and non-error text messages. If a POST error occurs, the screen will display the error message. 
To manually switch to the POST Messages Enabled mode during POST, press the Tab key. The 
default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested 
are determined by the POST mode selection.

Quick Power-On Self Test is a fast startup process that does not run all of the system level tests, 
such as the memory test. Disabling this feature causes all of the ROM-based system tests to run 
and booting takes longer to complete.
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POST Error Messages
POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section 
also includes some text messages that may be encountered during POST.

✎ The computer will beep once after a POST text message is displayed on the screen.

Numeric Codes and Text Messages 
Code/Message Probable Cause Recommended Action

BIOS ROM checksum 
error–System halted

The checksum of the BIOS 
code in the BIOS chip is 
incorrect, indicating that the 
BIOS code may have become 
corrupt.

Verify the correct ROM.
Flash the ROM is needed.
If an expansion card was recently added, 
remove it and see if the problem remains.
Clear CMOS.
If the message disappears, there may be a 
problem with the expansion card.
Replace the system board.

CMOS battery failed The CMOS battery is no 
longer functional.

Replace the RTC battery.

CMOS checksum 
error—Defaults 
loaded

Checksum of CMOS is 
incorrect, so the system loads 
the default equipment 
configuration. A checksum 
error may indicate that CMOS 
has become corrupt. A weak 
battery may have caused this 
error.

Check the battery and replace, if necessary.

CPU at nnnn Displays the running speed of 
the CPU.

None.

Press ESC to skip 
memory test

The user may press ESC to skip the full memory 
test.

HARD DISK INSTALL 
FAILURE

Cannot find or initialize the 
hard drive controller or the 
drive.

Make sure the controller is installed correctly in 
the BIOS. If no hard drives are installed, be 
sure the Hard Drive selection in Setup is set to 
NONE.

Keyboard error or no 
keyboard present

Cannot initialize the 
keyboard.

Make sure the keyboard is attached correctly 
and no keys are pressed during POST. To 
purposely configure the system without a 
keyboard, set the error halt condition in Setup 
to HALT ON ALL, BUT KEYBOARD. The BIOS 
then ignores the missing keyboard during 
POST.

Memory Test: This message displays during 
a full memory test, counting 
down the memory areas being 
tested.

None.
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POST Error Messages
Memory test fail If POST detects an error 
during memory testing, 
additional information 
appears giving specifics about 
the type and location of the 
memory error.

Shut down the system, reseat the DIMMs, and 
reboot the system. If the problem persists, 
replace the DIMMs.

Override enabled– 
Defaults loaded

If the system cannot boot using 
the current CMOS 
configuration, the BIOS can 
override the current 
configuration with a set of 
BIOS defaults designed for the 
most stable, minimal- 
performance system.

None.

Error: Non-System 
disk or disk error. 
Replace and press 
any key when ready

The BIOS was unable to find a 
suitable boot device. This may 
mean an unitialized or corrupt 
ATA flash.

Shut down the system, ensure that the power 
and data cables of all storage devices are 
plugged in properly, and reboot the system.
Ensure all removable media have been 
removed.

Warning: CPU fan 
has failed. 

CPU fan weak (RPM < 1000) 
or not turning. 

Ensure that the CPU fan power cable is 
connected. If the problem persists, replace the 
fan.

Warning: System Fan 
has failed.

System fan weak (RPM < 
1000) or not turning.

Ensure that the System fan power cable is 
connected. If the problem persists, replace the 
fan.

Memory is running at 
Single Channel Mode

When two same size 
memories are put in slot 1 and 
3, this message will be 
displayed. 

For optimal performance, shut down the system 
and move the second DIMM from the XMM3 to 
the XMM2 socket.

Numeric Codes and Text Messages (Continued)
Code/Message Probable Cause Recommended Action
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POST Error Messages
POST Diagnostic Front Panel LEDs and Audible Codes
This section covers the front panel LED codes as well as the audible codes that may occur before 
or during POST that do not necessarily have an error code or text message associated with them.

✎ If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the 
computer and refer to the following table to determine the front panel LED codes. 
 
Recommended actions in the following table are listed in the order in which they should be 
performed.

Diagnostic Front Panel LEDs and Audible Codes 

Activity Beeps
Possible 
Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds. The 
Power LED will 
continue flashing 
until the problem is 
resolved.

None Computer in 
Suspend to 
RAM mode 
(some models 
only) or 
normal 
Suspend 
mode.

None required. Press any key or move 
the mouse to wake the computer.

Red Power LED 
flashes two times, 
once every second, 
followed by a 
two-second pause. 
The Power LED will 
continue flashing 
until the problem is 
resolved. (Pertains 
to CPU fan only)

None Processor 
thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The 
heatsink/fan 
assembly is 
not properly 
attached to 
the processor. 

1. Ensure that the computer air vents 
are not blocked and the processor 
cooling fan is running. Leave a 
4-inch (10.2-cm) clearance at the 
back of the system unit and above 
the monitor to permit the required 
airflow.

2. Open hood, press power button, 
and see if the processor fan spins. If 
the processor fan is not spinning, 
make sure the fan's cable is plugged 
onto the system board header. 
Ensure the fan is fully/properly 
seated or installed.

3. If fan is plugged in and seated 
properly, but is not spinning, then 
replace processor fan.

4. Reseat processor heatsink and verify 
that the fan assembly is properly 
attached.
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POST Error Messages
Red Power LED 
flashes three times, 
once every second, 
followed by a 
two-second pause. 
The Power LED will 
continue flashing 
until the problem is 
resolved.

None Processor not 
installed (not 
an indicator 
of bad 
processor).

1. Check to see that the processor is 
present.

2. Reseat the processor.

Red Power LED 
flashes four times, 
once every second, 
followed by a 
two-second pause. 
The Power LED will 
continue flashing 
until the problem is 
resolved.

None Power failure 
(power supply 
overloaded).

1. Open the hood and ensure the 
4-wire power supply cable is seated 
into the connector on the system 
board.

2. Check if a device is causing the 
problem by removing ALL attached 
devices (such as hard, diskette, or 
optical drives, and expansion 
cards). Power on the system. If the 
system enters the POST, then power 
off and replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the device 
that is causing the failure. Continue 
adding devices one at a time to 
ensure all devices are functioning 
properly.

3. Replace the power supply.
4. Replace the system board.

Red Power LED 
flashes five times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps five times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

5 Pre-video 
memory error.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory with HP 
memory.

4. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps
Possible 
Cause Recommended Action
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POST Error Messages
Red Power LED 
flashes six times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps six times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

6 Pre-video 
graphics 
error. 

For systems with a graphics card:
1. Reseat the graphics card. Power on 

the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.

Red Power LED 
flashes seven times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps seven times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

7 System board 
failure (ROM 
detected 
failure prior to 
video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps eight times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

8 Invalid ROM 
based on bad 
checksum.

1. Reflash the ROM using a ROMPaq 
diskette. See the “ROM Flash” 
section of the Desktop Management 
Guide on the Documentation CD.

2. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps
Possible 
Cause Recommended Action
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Red Power LED 
flashes nine times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps nine times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

9 or 
None, 

depending 
on the 
issue

System 
powers on but 
is unable to 
boot.

1. Check that the voltage selector, 
located on the rear of the power 
supply (some models), is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.

2. Replace the system board.
3. Replace the processor.

Red Power LED 
flashes ten times, 
once every second, 
followed by a 
two-second pause, 
and the computer 
beeps ten times. 
Beeps stop after 
five times but the 
Power LED will 
continue flashing 
until the problem is 
resolved.

10 Bad option 
card.

1. Check each graphics card by 
removing the card (one at a time if 
multiple cards), then power on the 
system to see if fault goes away.

2. Once a bad card is identified, 
remove and replace the bad option 
card.

3. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps
Possible 
Cause Recommended Action
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System does not 
power on and LEDs 
are not flashing.

None System unable 
to power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
turns green, then:
1. Check that the voltage selector, 

located on the rear of the power 
supply, is set to the appropriate 
voltage. Proper voltage setting 
depends on your region.

2. Remove the expansion cards one at 
a time until the 5V_aux light on the 
system board turns on.

3. Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
does not turn on green then:
1. Check that the unit is plugged into a 

working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. Check to see if the 5V_aux light on 
the system board is turned on. If it is 
turned on, then replace the power 
button harness.

5. If the 5V_aux light on the system 
board is not turned on, then replace 
the power supply.

6. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps
Possible 
Cause Recommended Action
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D
Troubleshooting Without Diagnostics

Preliminary Checklist
This section describes some simple, preliminary tests and guidelines for troubleshooting the 
computer without using the diagnostics.

■ Are the computer and monitor connected to a working electrical outlet?

■ Is the voltage select switch is set to the appropriate voltage for your region (115V or 230V)?

■ Is the computer turned on?

■ Is the green power light illuminated?

■ Is the monitor turned on?

■ Is the green monitor light illuminated?

■ Turn up the monitor brightness and contrast controls if the monitor is dim.

■ If the system has multiple video sources (embedded, PCI, or PCI Express adapters) installed 
(embedded video on some models only) and a single monitor, the monitor must be plugged 
into the monitor connector on the source selected as the primary VGA adapter. During boot, 
the other monitor connectors are disabled and if the monitor is connected into these ports, the 
monitor will not function. You can select which source will be the default VGA source in 
Computer (F10) Setup.

■ Press and hold any key. If the system beeps, then the keyboard is operating correctly.

■ Check all cables for loose or incorrect connections.

■ Reconfigure the computer after installing a non–Plug and Play expansion board or other 
option, such as a diskette drive.

■ Are all of the necessary device drivers installed?

■ Have all printer drivers been installed for each application?

■ Remove all diskettes from the diskette drives before you turn on the system.

■ Are all switches set correctly?

■ Is the NIC Remote Wakeup cable (featured on some models) connected between the NIC and 
the riser/system board?
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Troubleshooting Without Diagnostics
Solving Minor Problems

Solving Minor Problems 
Problem Cause Possible Solution

Computer appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

1. Press and hold the power button 
for at least four seconds until the 
computer turns off.

2. Disconnect electrical plug from 
outlet.

Computer will not 
respond to USB 
keyboard or mouse.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

System has locked up. Restart computer.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the power 
button for more than four seconds. Otherwise, the computer will shut down and you will lose 
your unsaved data.

Computer date and 
time display is 
incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

1. Reset the date and time under 
Control Panel. 

2. Replace the RTC battery.

Computer appears to 
pause periodically.

Network driver is loaded 
and no network 
connection is established.

Establish a network connection, or 
use Computer Setup or Microsoft 
Windows Device Manager to disable 
the network controller.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The Num 
Lock key can be disabled (or 
enabled) in Computer Setup.

Devices connected to 
USB ports do not 
operate.

The Front Panel USB Port 
may be disabled in 
Computer Setup. This 
option controls the front 
USB port and the two USB 
ports on the back of the 
computer under the NIC 
connector.

Enable the Front Panel USB Port in 
Computer Setup. If the problem 
persists, contact an authorized 
service center.

Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

1. Unlock the Smart Cover Lock 
using Computer Setup.

2. Use the Smart Cover FailSafe 
Key in case of forgotten 
password, power loss, or 
computer malfunction.
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Poor performance is 
experienced.

Processor is hot. 1. Ensure airflow to the computer is 
not blocked.

2. Ensure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Ensure the processor heatsink is 
installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive. 

Program previously 
accessed did not release 
reserved memory back to 
the system.

Restart the computer.

Virus resident on the hard 
drive.

Run virus protection program.

Too many applications 
running.

1. Close unnecessary applications 
to free up memory.

2. Add more memory.

Cause unknown. Restart the computer.

Computer powered off 
automatically and the 
Power LED flashes Red 
two times, once every 
second, followed by a 
two second pause.

Processor thermal 
protection activated:
A fan may be blocked or 
not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure computer air vents are not 
blocked and the cooling fan is 
running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If not spinning, make sure 
the fan's cable is plugged onto 
the system board header. Ensure 
the fan is fully/properly seated or 
installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

Solving Minor Problems (Continued)
Problem Cause Possible Solution
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System does not power 
on and the LEDs on the 
front of the computer 
are not flashing.

System unable to power 
on.

Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED turns green, then:
1. Check that the voltage selector is 

set to the appropriate voltage. 
2. Remove the expansion cards one 

at a time until the 5V_aux light on 
the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED does not turn on green then:
1. Check that the unit is plugged 

into a working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. If the 5V_aux light on the system 
board is on, then replace the 
power button harness.

5. If the 5V_aux light on the system 
board is off, then replace the 
power supply.

6. Replace the system board.

Solving Minor Problems (Continued)
Problem Cause Possible Solution
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Troubleshooting Without Diagnostics
Solving Power Supply Problems
Solving Power Supply Problems 
Problem Cause Solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of computer 
chassis not switched to 
correct line voltage.

Select the proper AC voltage.

Power supply fault. Replace the power supply.

Computer powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause. (Pertains to CPIU 
fan only)

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink/fan 
assembly is not 
properly attached to the 
processor.

1. Ensure that the computer air 
vents are not blocked and the 
cooling fan is running.

2. Open hood, press the power 
button, and see if the processor 
fan spins. If the processor fan is 
not spinning, make sure the 
fan's cable is plugged onto the 
system board header. Ensure 
the fan is fully/properly seated 
or installed.

3. Replace the processor fan.
4. Reseat processor heatsink and 

verify that the fan assembly is 
properly attached.

Power LED flashes Red four 
times, once every second 
followed by a two-second 
pause.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector, 
is set to the appropriate 
voltage. 

2. Open the hood and ensure the 
4- wire power supply cable is 
seated into the connector on the 
system board.

3. Check if a device is causing the 
problem by removing ALL 
attached devices). Power on the 
system. If the system enters the 
POST, then power off and 
replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the 
device causing the failure. 
Continue adding devices one at 
a time to ensure all devices are 
functioning properly.

4. Replace the power supply.
5. Replace the system board.
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Solving Diskette Problems
Solving Diskette Problems 
Problem Cause Solution

Diskette drive light 
stays on.

Diskette is damaged. In Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive cable is not 
properly connected.

Reconnect power cable. Ensure that 
all four pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cables.

Removable drive is not 
seated properly.

Reseat the drive.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is 
left on the diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the 
storage security feature disabled 
settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be write 
protected.

Open the locking device on the 
diskette.

A problem has occurred 
with a disk transaction.

The directory structure 
is bad, or there is a 
problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.
D–6 361685-001 Service Reference Guide, dx5150



Troubleshooting Without Diagnostics
Diskette drive cannot read 
a diskette.

Diskette is not 
formatted.

Format the diskette.

You are using the 
wrong diskette type for 
the drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a 
new one.

“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart the computer by pressing the 
power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

Run Computer Setup and enable 
diskette boot in Storage > Boot 
Order.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options.

Network server mode is 
enabled in Computer 
Setup.

Enter Computer Setup and move the 
network interface card to the last 
position in Advanced BIOS 
Features > Removable Device 
Priority.

Solving Diskette Problems (Continued)
Problem Cause Solution
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Solving Hard Drive Problems
Solving Hard Drive Problems 
Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

1. In Windows XP, right-click 
Start, click Explore, and 
select a drive. Select File > 
Properties > Tools. Under 
Error-checking, click Check 
Now.

2. Use a utility to locate and block 
usage of bad sectors. If 
necessary, reformat the hard 
disk.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

1. Run Computer Setup.
2. If the system still does not 

recognize the new device, 
check to see if the device is 
listed within Computer Setup. If 
it is listed, the probable cause is 
a driver problem. If it is not 
listed, the probable cause is a 
hardware problem.

3. If this is a newly installed drive, 
enter Computer Setup and 
disable the Quick Power On 
Self Test in Advanced BIOS 
Features.

Drive’s controller is 
disabled in Computer 
Setup.

Enter Computer Setup and enable 
all the IDE and SATA controllers in 
Integrated Peripherals > 
South OnChip IDE Device and 
Integrated Peripherals > 
South OnChip PCI Device.

Drive responds slowly 
immediately after 
power-up.

Enter Computer Setup and disable 
the Quick Power On Self Test in 
Advanced BIOS Features.
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Nonsystem disk/NTLDR 
missing message.

System is trying to start 
from a non bootable 
diskette.

Remove the diskette from the 
diskette drive

System is trying to start 
from a damaged hard 
drive.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check the hard drive format 
using fdisk: 
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image.

System files missing or 
not properly installed.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check the hard drive format 
using Fdisk: 
If NFTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image.

Hard drive boot 
disabled in Computer 
Setup.

Enter Computer Setup and enable 
the hard drive in Integrated 
Peripherals > South OnChip 
IDE Device > OnChip IDE 
Channel 0 or 1.
- or -
Enter Computer Setup and enable 
the hard drive in Integrated 
Peripherals > South OnChip 
PCI Device > Onboard Chip 
SATA.

Bootable hard drive is 
not attached as first in a 
multi-hard drive 
configuration.

If attempting to boot from a SATA 
hard drive, ensure it is attached to 
SATA 0.

Solving Hard Drive Problems (Continued)
Problem Cause Solution
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Computer will not start. Hard drive is damaged. Observe the beeps and LED lights 
on the front of the computer. See 
Appendix C, “POST Error 
Messages.”

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

1. Attempt the normal Windows 
“Shut Down” procedure. 

2. Press the power button for 
four or more seconds to turn off 
the power. 

3. Restart the computer using the 
power button.

Solving Hard Drive Problems (Continued)
Problem Cause Solution
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Solving Display Problems

Solving Display Problems 
Problem Cause Solution

Blank screen (no video). The cable connections 
are not correct.

Check the cable connections from 
the monitor to the computer and to 
the electrical outlet.

Screen blanking utility 
installed or energy 
saver features enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

System ROM is bad; 
system is running in 
FailSafe Boot Block 
mode (indicated by 
eight beeps).

Reflash the ROM using a ROMPaq 
diskette.

Fixed-sync monitor will 
not sync at the 
resolution chosen.

Ensure that the monitor can accept 
the same horizontal scan rate as the 
resolution chosen.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose your unsaved data.

Monitor cable plugged 
into the wrong 
connector.

If the computer system has both 
an integrated graphics connector 
and an add-in graphics card 
connector, plug the monitor cable 
into the graphics card connector on 
the back of the computer.

Monitor settings in the 
computer are not 
compatible with the 
monitor.

1. Restart the computer and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode 
and press Enter.

3. In Windows Control Panel, 
double-click the Display icon 
and select the Settings tab.

4. Use the sliding control to reset 
the resolution.
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Blank screen and the 
power LED flashes Red five 
times, once every second, 
followed by a two-second 
pause, and the computer 
beeps five times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Pre-video memory error. 1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. 
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Blank screen and the 
power LED flashes Red 
seven times, once every 
second, followed by a 
two-second pause, and the 
computer beeps seven 
times. The beeps will 
repeat five times, but the 
Power LED will continue 
flashing until the problem is 
resolved.

System board failure 
(ROM detected failure 
prior to video).

Replace the system board.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics 
controller was 
upgraded, the correct 
video drivers may not 
be loaded.

Install the video drivers included in 
the upgrade kit.

Solving Display Problems (Continued)
Problem Cause Solution
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Blurry video or requested 
resolution cannot be set 
(continued)

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor 
connections may be 
incomplete or the 
monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing 
coil has been activated.

None. It is normal for the 
degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some 
monitors to make a clicking noise 
when turned on and off, when 
going in and out of standby mode, 
and when changing resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are too 
high.

Lower brightness and/or contrast 
settings.

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen. 
(flat panel monitors using 
an analog VGA input 
connection only)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display 
menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen 
display functions. Download 
SoftPaq SP20930 or SP22333, 
depending on the monitor, to 
assist with the synchronization.

Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy 
the symbol from the Character Map 
into a document.

Solving Display Problems (Continued)
Problem Cause Solution
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Solving Audio Problems

Solving Audio Problems 
Problem Cause Solution

Sound cuts in and out. Processor resources are 
being used by other 
open applications.

Shut down all open 
processor-intensive applications.

Direct sound latency, 
common in many media 
player applications.

In Windows XP:
1. From the Control Panel, 

select Sounds and Audio 
Devices.

2. On the Audio tab, select a 
device from the Sound 
Playback list.

3. Click the Advanced button 
and select the Performance 
tab.

4. Set the Hardware 
acceleration slider to None 
and the Sample rate 
conversion quality slider to 
Good and retest the audio.

Set the Hardware acceleration 
slider to Full and the Sample rate 
conversion quality slider to 
Best and retest the audio.

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on 
the taskbar and use the volume 
slider to adjust the volume.

Audio is hidden in 
Computer Setup.

Enable the audio in Computer 
Setup: Integrated Peripherals 
> South OnChip PCI Device.

The external speakers 
are not turned on.

Turn on the external speakers.

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Audio cable not 
connected.

Connect audio cable between CD 
or DVD-ROM drive and the system 
board.
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Sound does not come 
out of the speaker or 
headphones. (Continued)

Digital CD audio is not 
enabled.

Enable digital CD audio:
1. From the Control Panel, 

select System.
2. On the Hardware tab, click 

the Device Manager button.
3. Right-click on the CD/DVD 

device and select Properties.
4. On the Properties tab, make 

sure “Enable digital CD 
audio for this CD-ROM 
device” is checked.

Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, 
Speech and Audio 
Devices, then click Sounds 
and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose your unsaved data.

Noise or no sound comes 
out of the speakers or 
headphones.

Computer may not be 
detecting the correct 
speaker/headphone 
type or output or 
analog-to-digital 
auto-sense is not 
engaged.

1. The audio output jack supports 
both digital and analog output 
functions. When using digital 
speakers, switch the PC’s output 
jack to digital mode. Go to the 
Volume Control Panel, select 
the Advanced button, and 
select the Enable Digital Audio 
check box. When using 
conventional analog speakers, 
ensure this check box is not 
selected.

2. If the headphones have a mono 
jack, use the multimedia device 
properties to switch the system 
to analog out.

Solving Audio Problems (Continued)
Problem Cause Solution
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Solving Printer Problems

✎ If you set digital as the Output Mode, the internal speaker and external analog 
speakers will no longer output audio until you switch back to an auto-sense or  
analog mode. 
If you set analog as the Output Mode, external digital speakers will not function 
until you change the output mode back to an auto-sense or digital mode.

Computer appears to be 
locked up while recording 
audio.

The hard disk may be 
full.

1. Before recording, make sure 
there is enough free space on 
the hard disk. 

2. Try recording the audio file in a 
compressed format.

Solving Audio Problems (Continued)
Problem Cause Solution

Solving Printer Problems 
Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
driver for the 
application are not 
installed.

1. Install the correct printer driver 
for the application.

2. Try printing using the 
MS-DOS command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being 
used. If the printer works, 
reload the printer driver.

If you are on a network, 
you may not have 
made the connection 
to the printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables.

Printer prints garbled 
information.

The correct printer 
driver is not installed.

Install the correct printer driver for 
the application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

1. Check the paper tray and refill 
it if it is empty. 

2. Select online.
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Solving Keyboard and Mouse Problems

Solving Keyboard Problems
Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. Turn off the computer. 
2. Reconnect the keyboard to the 

back of the computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using 
the mouse and then restart the 
computer.

Keyboard needs 
repairs.

Replace the keyboard.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose your unsaved data.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled  
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

1. Shut down the computer using 
the keyboard.

2. Plug the mouse connector into 
the back of the computer (or the 
keyboard) and restart the 
computer.

Program in use has 
stopped responding 
to commands.

Shut down the computer using the 
keyboard and then restart the 
computer.

Mouse may need 
cleaning.

Remove the roller ball cover on the 
mouse and clean the internal 
components.

Mouse needs repairs. Replace the mouse.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down 
and you will lose your data.

Mouse will only move 
vertically or horizontally, or 
movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an 
additional diskette drive. If you install a plug and play device, Windows XP automatically 
recognize the device and configure the computer. If you install a non–plug and play device, you 
must reconfigure the computer after completing installation of the new hardware. In Windows 
XP, use the Add Hardware Wizard and follow the instructions that appear on the screen.

Solving Hardware Installation Problems 
Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of changes 
to the configuration, 
you did not accept 
them.

Reboot the computer and follow the 
instructions for accepting the 
changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows XP Device Manager 
to deselect the automatic settings for 
the board and choose a basic 
configuration that does not cause a 
resource conflict. You can also use 
Computer Setup to reconfigure or 
disable devices to resolve the 
resource conflict.

Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to 
determine if you are using the 
correct memory modules and to 
verify the proper installation.

2. Observe the beeps and LED 
lights on the front of the 
computer. See Appendix C, 
“POST Error Messages,” to 
determine possible causes.
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Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Video card is not 
seated properly or is 
bad, or system board is 
bad.

For systems with a graphics card:
1. Reseat the graphics card. 

Power on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Power LED flashes Red ten 
times, once every second, 
followed by a two-second 
pause, and the computer 
beeps ten times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Bad option card. 1. Check each option card by 
removing the cards one at time 
(if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once bad card is identified, 
remove and replace bad option 
card.

3. Replace the system board.

Solving Hardware Installation Problems (Continued)
Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Solving Network Problems 
Problem Cause Solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Use the Network control 
application to enable 
Wake-on-LAN. 

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

Run Computer Setup and enable 
network controller.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light 
does not turn on or it 
never flashes.

✎ The network status 
light should flash 
when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Use the Network control 
application to verify that the device 
is working properly. 

Network driver is not 
properly loaded.

Reinstall network drivers. 

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the 
correct operating mode. 

Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that both ends of the data 
cable are securely connected. 

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Enter Computer Setup and change 
the resource settings for the board 
in PnP/PCI Configurations > 
IRQ Resources.

The network controller 
is defective.

Replace the NIC.

Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are 
not loaded, or driver 
parameters do not match 
current configuration.

1. Make sure the network drivers 
are loaded and that the driver 
parameters match the 
configuration of the network 
controller.

2. Make sure the correct network 
client and protocol is installed.
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Diagnostics passes, but 
the computer does not 
communicate with the 
network. (continued)

The network controller 
is not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Enter Computer Setup and change 
the resource settings for the board 
in PnP/PCI Configurations > 
IRQ Resources.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Enter Computer Setup and change 
the resource settings for the board 
in PnP/PCI Configurations > 
IRQ Resources.

Network controller stops 
working without 
apparent cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using 
the Restore Plus! CD.

The cable is not securely 
connected.

Ensure that both ends of the cable 
are securely attached to the correct 
devices.

The network controller is 
defective.

Replace the NIC.

New network card will 
not boot.

New network card may 
be defective or may not 
meet industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence 
to boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that 
the Remote System Installation 
Server contains the NIC drivers for 
your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving Network Problems (Continued)
Problem Cause Solution
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Troubleshooting Without Diagnostics
Solving Memory Problems

Ä
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC 
memory. Otherwise, the system will not boot the operating system.

Solving Memory Problems 
Problem Cause Solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

Memory module is not 
the correct type or 
speed or the new 
memory module is not 
seated properly.

Replace module with the correct 
industry-standard device for the 
computer.

On some models, ECC and 
non-ECC memory modules cannot 
be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during 
POST is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Integrated graphics 
may use system 
memory.

No action required.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more 
memory to the computer.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times. The beeps 
will repeat five times, but 
the Power LED will continue 
flashing until the problem is 
resolved.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to 

isolate the faulty module.
3. Replace third-party memory 

with HP memory.
4. Replace the system board.
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Solving Processor Problems

Solving Processor Problems
Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked. Leave 
a 10.2-cm (4-inch) clearance at 
the back of the system unit and 
above the monitor to permit the 
required airflow.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Power LED flashes Red 
three times, once every 
second, followed by a 
two-second pause. The 
Power LED will continue 
flashing until the problem is 
resolved.

Processor is not seated 
properly or not 
installed. (This is not an 
indicator of a bad 
processor)

1. Check to see that the processor 
is present.

2. Reseat the processor.
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Solving CD-ROM and DVD Problems

Solving CD-ROM and DVD Problems 
Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

Removable Media Boot 
is disabled in the 
Computer Setup utility.

Enter Computer Setup and enable 
CD-ROM or DVD drive boot in 
Integrated Peripherals > 
South OnChip IDE Device > 
OnChip IDE Channel 0 or 1.

Network Server Mode 
is enabled in Computer 
Setup.

Enter Computer Setup and move the 
network interface card to the last 
position in Advanced BIOS 
Features > Removable Device 
Priority.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

Boot order not correct. Enter Computer Setup and change 
boot sequence in Advanced 
BIOS Features and Advanced 
BIOS Features > Removable 
Device Priority.

CD-ROM or DVD devices 
are not detected or driver 
is not loaded.

Drive is not connected 
properly or not properly 
configured.

1. Reconnect power and data 
cables to the drive.

2. Install correct device driver.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Damaged media. Replace media.

Movie rating locked out 
by parental lock.

Use DVD software to remove 
parental lock.

Cannot eject compact disc 
(tray-load unit).

Disc not properly 
seated in the drive.

1. Turn off the computer and insert 
a thin metal rod into the 
emergency eject hole and push 
firmly. 

2. Slowly pull the tray out from the 
drive until the tray is fully 
extended, then remove the disc.
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Solving Drive Key Problems

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

Media has been 
inserted upside down.

Re-insert the media with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove 
or uninstall the device in 
question.

2. Restart the computer and let 
Windows detect the device.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower recording 
speed.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

Solving CD-ROM and DVD Problems (Continued)
Problem Cause Solution

Solving Drive Key Problems
Problem Cause Solution

Drive key is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for 
the Drive key in Windows XP.

The computer boots to 
DOS after making a 
bootable Drive key.

Drive key is bootable. Install the Drive key after the 
operating system boots.
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Solving Internet Access Problems

Solving Internet Access Problems 
Problem Cause Solution

Unable to connect to the 
Internet.

Internet Service 
Provider (ISP) account is 
not set up properly.

Verify Internet settings or contact the 
ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the 
quick setup documentation.

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/ DSL modem is 
not plugged in.

Plug in cable/DSL modem. You 
should see a “power” LED light on 
the front of the cable/DSL modem.

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 UTP cable is 
disconnected.

Connect the CAT5 UTP cable 
between the cable modem and the 
computers’s RJ-45 connector. (If the 
connection is good, the “PC” LED 
light on the front of the cable/DSL 
modem will be on.)

IP address is not 
configured properly.

Contact the ISP for the correct IP 
address.

Cookies are corrupted. In Windows XP
1. Select Start > Control 

Panel.
2. Double-click Internet 

Options.
3. On the General tab, click the 

Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to the 
ISP before some 
programs will start.

Log on to the ISP and launch the 
desired program.
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Solving Software Problems
Most software problems occur as a result of the following:

■ The application was not installed or configured correctly.

■ There is insufficient memory available to run the application.

■ There is a conflict between applications.

■ Make sure that all the needed device drivers have been installed.

■ If you have installed an operating system other than the factory-installed operating system, 
check to be sure it is supported on the system.

Where available, run the Configuration Record utility to determine if any changes have been 
made to the software which may be causing a problem. 

If you encounter software problems, see the applicable solutions listed in the following table.

Internet takes too long to 
download Web sites.

Modem is not set up 
properly.

Verify that the correct modem speed 
and COM port are selected.
For Windows XP:
1. Select Start > Control 

Panel.
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port your 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Solving Internet Access Problems (Continued)
Problem Cause Solution
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Troubleshooting Without Diagnostics
Solving Software Problems 
Problem Cause Solution

Computer will not continue 
and no HP logo screen has 
appeared.

POST error has 
occurred.

Observe the beeps and LED lights 
on the front of the computer.  
See Appendix C, “POST Error 
Messages” to determine possible 
causes.
See the Restore Kit or the 
Worldwide Limited Warranty for 
terms and conditions.

Computer will not continue 
after HP logo screen has 
appeared.

System files may be 
damaged.

Use recovery diskette to scan hard 
drive for errors.

“Illegal Operation has 
Occurred” error message 
is displayed.

Software being used is 
not Microsoft-certified 
for your version of 
Windows.

Verify that the software is certified 
by Microsoft for your version of 
Windows (see program packaging 
for this information).

Configuration files are 
corrupt.

If possible, save all data, close all 
programs, and restart the computer.
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E
Memory

AMD-Based Systems
Computers equipped with AMD-based processors come with Double Data Rate-Synchronous 
Dynamic Random Access Memory (DDR-SDRAM) Dual Inline Memory Modules (DIMMs).

DIMMs
The memory sockets on the system board can be populated with up to four industry-standard 
DIMMs. These memory sockets are populated with at least one preinstalled DIMM. To achieve 
the maximum memory support, you can populate the system board with up to 8GB (1-Gbit 
Technology) of memory configured in a high-performing dual channel mode.

✎ The memory available may be limited by the operating system.

DDR-SDRAM DIMMs
For proper system operation, if the computer supports DDR-SDRAM DIMMs, 
the DIMMs must be:

■ industry-standard 184-pin

■ unbuffered PC3200 400 MHz-compliant

■ 2.5 volt DDR-SDRAM DIMMs.

The DDR-SDRAM DIMMs must also:

■ support CAS latency 3 (CL = 3)

■ contain the mandatory JEDEC SPD information

In addition, the computer supports:

■ 128Mbit, 256Mbit, 512Mbit, and 1Gbit non-ECC memory technologies

■ single-sided and double-sided DIMMS 

■ DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM 
are not supported 

✎ The system will not start if you install unsupported DIMMs.
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Memory
DIMM Sockets
The system will automatically operate in single channel mode or a higher-performing dual 
channel mode, depending on how the DIMMs are installed.

■ In single channel mode, always populate the XMM1 socket first. If you add a second DIMM 
of a different memory size than the first, install it in XMM3. Otherwise, the system will not 
operate.

✎ In single channel mode, the maximum operational speed is determined by the slowest DIMM in 
the system. If the system is populated with a DIMM that is 266 MHz and a second DIMM that is 
333 MHz, the system will run at the slower of the two speeds.

■ In dual channel mode, all DIMMs must be identically matched. If you are populating all four 
DIMM sockets, you must either use identical DIMMs in all sockets or use identical DIMM 
pairs in each pair of sockets, XMM1 and XMM2 black sockets and XMM3 and XMM4 blue 
sockets. Otherwise, the system will not operate.

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are 
labeled XMM1, XMM2, XMM3, and XMM4. Sockets XMM1 and XMM3 operate in memory 
channel A. Sockets XMM2 and XMM4 operate in memory channel B.

The system board shown below may be different from the one in your computer.

Item Description Socket Color

1 DIMM socket XMM1, Channel A Black

2 DIMM socket XMM2, Channel B Black

3 DIMM socket XMM3, Channel A Blue

4 DIMM socket XMM4, Channel B Blue
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4-pin power pin assignments A–7
24-pin MicroFit power pin assignments A–7
24-pin power pin assignments A–6
3.5" drive bezel, MT removal and replacement 6–6
5.25" drive bezel, MT removal and replacement 

6–5

A
access panel, MT removal and replacement 6–3
access to computer, controlling 3–9
asset tracking 3–9
ATA/ATAPI (IDE) drive cable pin assignments 

A–6
audible codes C–4

B
battery

disposal 5–9
MT removal and replacement 6–29
real-time clock D–2
SFF removal and replacement 7–25

beep codes C–4
blank screen D–11
bootable disk, important information 3–15

C
cable

MT removal and replacement 6–14
proper handling 5–8
SFF removal and replacement 7–16

cable layout, PATA 4–4
cable lock

MT 6–2
SFF 7–2

cable lock provision 3–15
cable management

CMT 6–7
cable pinouts

PATA data 4–3
PATA power 4–3
SATA data 4–1
SATA power 4–2

categories, Diagnostics for Windows 2–10
cautions

AC power 5–1
adding devices 1–1
batteries 5–9
cables 5–8
cooling fan 5–7
keyboard cleaning 5–6
keyboard keys 5–6
operating system installation 1–1
protecting ROM 3–4

changing operating systems, important information 
3–9

chassis fan
MT removal and replacement 6–20
SFF removal and replacement 7–24

chassis types, illustrated 5–1
cleaning

computer 5–6
keyboard 5–6
monitor 5–6
mouse 5–7

cloning tools, software 3–1
CMT

cable management 6–7
computer

cleaning 5–6
computer pauses D–2
Configuration Record Utility 2–13
configuring power button 3–8
connector pin assignments A–1 to A–7
controlling access to computer 3–9
country-specific power cord set requirements B–2
customizing software 3–1

D
date and time display D–2
deployment tools, software 3–1
device drivers

installing/upgrading 1–1
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Index
Diagnostics for Windows
categories 2–10
detecting 2–9
installing 2–9
Menu Bar 2–11
overview 2–9
running tests 2–12

DIMMs E–1
disassembly preparation

MT 6–1
SFF 7–1

disconnecting
MT diskette drive cable 6–15
MT hard drive cable 6–15
MT optical drive cable 6–14

disk, cloning 3–1
diskette drive bezel

MT removal and replacement 6–6
SFF removal and replacement 7–6

diskette drive cable
MT connecting 6–18
MT disconnecting 6–15

drive
capacities 4–6
MT removal and replacement 6–14
partition size 4–6

drive bezel
SFF removal and replacement 7–6

drive positions
MT 6–13
SFF 7–10

dual-state power button 3–8

E
electrostatic discharge. See ESD
entering

power-on password 3–12
error codes C–1
ESD (electrostatic discharge)

information 5–2
materials and equipment 5–4
preventing damage 5–3

Ethernet
AUI pin assignments A–2
BNC pin assignments A–1
RJ-45 pin assignments A–2

expansion card
MT removal and replacement 6–11
SFF removal and replacement 7–9

expansion slot cover

MT removal and replacement 6–10
SFF removal and replacement 7–8

external 3.5-inch drive
SFF removal and replacement 7–17

external security
MT 6–2
SFF 7–2

F
fan

MT chassis removal and replacement 6–20
power supply 5–7
ST chassis 7–24

FAT or FAT32 to NTFS conversion 1–2
flashing LEDs C–4
formatting disk, important information 3–15
front bezel

MT removal and replacement 6–4
SFF removal and replacement 7–5

front I/O devices
MT removal and replacement 6–22
SFF removal and replacement 7–21

front I/O panel
MT removal and replacement 6–21

G
grounding methods 5–3

H
hard drive

proper handling 5–8
SFF removal and replacement 7–19

hard drive cable
MT disconnecting 6–15
MT connecting 6–19

headphone pin assignments A–3
heatsink

MT removal and replacement 6–26
MT removaland replacement 6–25
SFF removal and replacement 7–28

HP Client Manager 3–2
HP software. See software

I
infrared (IR) transceiver, external, pin assignments 

A–5
initial configuration 3–1
installing Diagnostics for Windows 2–9
Internet addresses, See Web sites
invalid system ROM 3–5
IR transceiver. See infrared (IR) transceiver
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Index
K
keyboard

cleaning 5–6
pin assignments A–1

L
LEDs

blinking power C–4
blinking PS/2 keyboard C–4

line-in audio pin assignments A–3
line-out audio pin assignments A–4

M
Master Boot Record Security, setting 3–13
memory

dual channel mode E–2
locating sockets E–2
MT removal and replacement 6–9
SFF removal and replacement 7–7
specifications E–1

menu bar, Diagnostics for Windows 2–11
microphone pin assignments A–3
µT

chassis, illustrated 5–1
MT

3.5" drive bezel removal and replacement 6–6
5.25" drive bezel removal and replacement 6–5
access panel removal and replacement 6–3
battery removal and replacement 6–29
cable lock 6–2
chassis fan removal and replacement 6–20
disassembly preparation 6–1
diskette drive bezel removal and replacement 

6–6
diskette drive cable, connecting 6–18
diskette drive cable, disconnecting 6–15
drive positions 6–13
drive removal and replacement 6–14
expansion card removal and replacement 6–11
expansion slot cover 6–10
external security 6–2
front bezel removal and replacement 6–4
front I/O devices removal and replacement 6–22
front I/O panel removal and replacement 6–21
hard drive cable, connecting 6–19
hard drive cable disconnecting 6–15
heatsink removal and replacement 6–26
memory removal and replacement 6–9
optical drive cable, connecting 6–18
optical drive cable, disconnecting 6–14
padlock 6–2

PCI expansion card removal and replacement 
6–11

power supply removal and replacement 6–34
power switch assembly removal and 

replacement 6–23
preparation for disassembly 6–1
processor removal and replacement 6–26
speaker removal and replacement 6–33
system board removal and replacement 6–27, 

7–30
monitor

blank screen D–11
blurry video D–12
checking connections D–1
cleaning 5–6
dim characters D–12
pin assignments A–5

mouse
cleaning 5–7
pin assignments A–1

MT
heatsink removal and replacement 6–25

N
numeric codes C–2

O
operating systems, important information about 

3–9
optical drive

connecting SFF cables 7–16
SFF removal and replacement 7–14

optical drive cable
MT connecting 6–18
MT disconnecting 6–14

overheating, prevention 5–5

P
padlock

MT 6–2
SFF 7–3

parallel interface pin assignments A–2
partitioning disk, important information 3–15
password

power-on 2–1, 3–12
password security 3–11
PATA

cable layout 4–4
data cable pinouts 4–3
power cable pinouts 4–3
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PCI expansion card
MT removal and replacement 6–11

PCI Express pin assignments A–8
POST

enabling error messages C–1
POST (Power-On Self-Test) 2–1
power button

configuring 3–8
dual-state 3–8

power cord set requirements
country specific B–2
general B–1

power supply
fan 5–7
MT removal and replacement 6–34
SFF removal and replacement 7–32

power supply, surge-tolerant 3–15
power switch assembly

MT removal and replacement 6–23
SFF removal and replacement 7–22

power-on password 2–1
entering 3–12

Power-On Self-Test (POST) 2–1
Preboot Execution Environment (PXE) 3–2
preinstalled software image 3–1
primary hard drive, SFF removal and relacement 

7–19
problems

software D–27
problems, solving

audio D–14
CD-ROM and DVD D–24
diskette D–6
display D–11
drive key D–25
hard drive D–8
installing hardware D–18
Internet access D–26
keyboard D–17
memory D–22
network D–20
optical drives D–24
power supply D–5
printer D–16

processor
MT removal and replacement 6–26

SFF removal and replacement 7–29
protecting

ROM, caution 3–4
software 2–14

PXE (Preboot Execution Environment) 3–2

Q
Quick Power-On Self Test C–1

R
recovering system 3–5
recovery, software 3–1
Remote Diagnostics Enabling Agent 2–14
Remote ROM Flash 3–4
remote setup 3–2
Remote System Installation, accessing 3–2
removal and replacement

MT 3.5" drive bezel 6–6
MT 5.25" drive bezel 6–5
MT access panel 6–3
MT battery 6–29
MT cable lock 6–2
MT chassis fan 6–20
MT diskette drive bezel 6–6
MT drive 6–14
MT expansion card 6–11
MT front bezel 6–4
MT front I/O devices 6–22
MT front I/O panel 6–21
MT heatsink 6–26
MT memory 6–9
MT padlock 6–2
MT PCI expansion card 6–11
MT power supply 6–34
MT power switch assembly 6–23
MT processor 6–25
MT speaker 6–33
MT system board 6–27, 7–30
SFF battery 7–25
SFF cable lock 7–2
SFF chassis fan 7–24
SFF diskette drive bezel 7–6
SFF expansion slot cover 7–8
SFF external 3.5-inch drive 7–17
SFF front bezel 7–5
SFF front drive bezel 7–6
SFF front I/O devices 7–21
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SFF memory 7–7
SFF optical drive 7–14
SFF padlock 7–3
SFF power supply 7–32
SFF power switch assembly 7–22
SFF primary hard drive 7–19
SFF processor 7–29
SFF speaker 7–23

required tools and software 5–7
restoring software 2–14
ROM, invalid 3–5
running tests,Diagnostics for Windows 2–12

S
safety precautions, cleaning 5–5
SATA

data cable pinouts 4–1
power cable pinouts 4–2

SATA pin assignments A–7
screws, correct size 5–7
SCSI pin assignments A–4
security

MT 6–2
SFF 7–2

security settings, setup of 3–9
security, master boot record 3–13
serial interface pin assignments A–3
service considerations 5–7
setup

software 1–3
windows 1–1

setup, initial 3–1
SFF

battery removal and replacement 7–25
cable lock 7–2
chassis fan removal and replacement 7–24
disassembly preparation 7–1
diskette drive bezel removal and replacement 

7–6
drive positions 7–10
expansion slot cover removal and replacement 

7–8
external 3.5-inch drive removal and replacement 

7–17
external security 7–2
front bezel removal and replacement 7–5
front drive bezel removal and replacement 7–6
front I/O devices removal and replacement 7–21

heatsink removal and replacement 7–28
memory removal and replacement 7–7
optical drive removal and replacement 7–14
padlock 7–3
power supply removal and replacement 7–32
power switch assembly removal and 

replacement 7–22
preparation for disassembly 7–1
processor removal and replacement 7–29
speaker removal and replacement 7–23

software
asset tracking 3–9
Computer Setup Utilities 2–1
integration 3–1
Master Boot Record Security 3–13
protecting 2–14
recovery 3–1
Remote ROM Flash 3–4
Remote System Installation 3–2
required 5–7
restoring 2–14
setup 1–3
System Software Manager 3–3
updating multiple machines 3–3

software problems D–27
spare part number

screwdriver, Torx T-15 5–7
wrench, tamper-resistant 5–7

speaker
MT removal and replacement 6–33
SFF removal and replacement 7–23

SSM (System Software Manager) 3–3
static electricity 5–3
surge-tolerant power supply 3–15
system board

MT removal and replacement 6–27, 7–30
system recovery 3–5
System Software Manager (SSM) 3–3

T
temperature control 5–5
tools, required 5–7

U
Ultra SCSI pin assignments A–4
URLs (Web sites). See Web sites
USB pin assignments A–3
Service Reference Guide, dx5150 361685-001 Index–5



Index
V
ventilation, proper 5–5

W
Wake-on-LAN feature D–20
warnings, battery 5–9
Web sites

HP 1–1, 1–3
HP Client Manager Software 3–2
HPQ Flash 3–5

PC Deployment 3–1
Remote ROM Flash 3–4
ROM Flash 3–4
ROMPaq images 3–4
support software 3–9
support software CD subscription 1–1
System Software Manager 3–3

World Wide Web addresses. See Web sites
wrench, tamper-resistant 5–7
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